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TRADEMARKS
ASAP is a registered trademark of Micromeritics Instrument Corporation.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Python is a registered trademark of Python Software Foundation.
Teflon is a registered trademark of E. I. DuPont de Nemours Company.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under
the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the
use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list
of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and
must not be misrepresented as being the original source. Such altered versions also must not be mis-
represented as being Info-ZIP releases — including, but not limited to, labeling of the altered versions with
the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further pro-
hibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases

Copyright

The software described in thismanual is furnished under a license agreement andmay be used or
copied only in accordance with the terms of the agreement.

______________________________________________________________________________

Copyright © 2013-2018. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fitness for use.

Warranty
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About Micromeritics

ABOUT MICROMERITICS

Micromeritics Instruments Corporation is a leading global provider of solutions for material
characterization with best-in-class instrumentation and application expertise in five core areas:
density; surface area and porosity; particle size and shape; powder characterization; and catalyst
characterization and process development. Founded in 1962, the company is headquartered in
Norcross, Georgia, USA and hasmore than 300 employeesworldwide.With a fully integrated
operation that extends from aworld class scientific knowledge base through to in-house
manufacture, Micrometrics delivers an extensive range of high-performance products for academic
research and industrial problem-solving. The implementation of tactical partnerships to incubate and
deliver valuable new technologies exemplifies the company’s holistic, customer-centric approach
which extends to a cost-efficient contract testing laboratory – the Particle Testing Authority (PTA).
The strategic acquisitions of Freeman Technology Ltd and Process Integral Development S.L. (PID
Eng & Tech) reflect an ongoing commitment to optimized, integrated solutions in the industrially vital
areas of powders and catalysis.

Freeman Technology (Tewkesbury, UK) bringsmarket-leading powder characterization technology
toMicromeritics’ existing portfolio of particle characterization techniques. The result is a suite of
products that directly supports efforts to understand and engineer particle properties tomeet powder
performance targets. With over 15 years of experience in powder testing, Freeman Technology
specializes in systems for measuring the flow properties of powders. In combination with detailed
application know-how these systems deliver unrivalled insight into powder behavior supporting
development, formulation, scale-up, processing andmanufacture across a wide range of industrial
sectors.

PID Eng & Tech (Madrid, Spain) complementsMicromeritics’ renowned offering for catalyst
characterization with technology for themeasurement and optimization of catalytic activity, with a
product range that extends to both standard and bespoke pilot scale equipment. Launched in 2003,
PID Eng & Tech is a leading provider of automated, modular microreactor systems for the detailed
investigation of reaction kinetics and yield. These products are supported by a highly skilled
multidisciplinary team of engineers with in-depth expertise in the design, construction and operation
of laboratory units and process scale-up.

The Particle Testing Authority (PTA) providesmaterial characterization services for fine powders
and solid materials usingMicromeritics’ instrumentation alongside complementary solutions from
other vendors. With the certification and expertise to operate across a wide range of industries the
PTA offering runs from single sample analysis to complexmethod development, method validation,
new product assessment, and the analytical support required for large scalemanufacturing projects.
An experienced, highly trained team of scientists, engineers, and lab techniciansworks closely with
every client to ensure that all analytical requirements are rapidly and responsively addressed.
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Micromeritics has a strong global network with offices across the Americas, Asia, and Europe
complemented by a dedicated team of distributors in additional locations. This ensures that local,
knowledgeable support is available for every customer, in academia or industry. Micromeritics works
across a truly diverse range of industries from oil processing, petrochemicals and catalysts, to food
and pharmaceuticals, and at the forefront of characterization technology for next generation
materials such as graphene, metal-organic-frameworks, nanocatalysts, and zeolites. Engineering
solutions that work optimally for every user is a defining characteristic of the company.

About Micromeritics
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Contact Us

CONTACT US
Micromeritics Instrument Corporation

4356 CommunicationsDrive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International— contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com
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ABOUT THIS MANUAL

Log in to your customer portal to access the following:

l Calculations
l Error Messages
l MicroActive ASAP 2460Operator Manual in PDF format
l MicroActive Report Tutorials
l Smart VacPrepOperator Manual in PDF format

Parts and accessories can be found online at www.Micromeritics.com.

Thismanual contains instructions for both standard installations and installations in
21CFR11 environments.

The following iconsmay be found in thismanual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).

About thisManual
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1 ANALYZER COMPONENTS

FRONT COMPONENTS

P0 port connector For P0 (saturation pressure) tube installation.

Power indicator Blinkswhen power is applied to the analyzer; illuminateswhen the
analysis program is initiated and ready for operation.

Sample port connector For sample tube installation.

Front Components

1 Analyzer Components
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1 Analyzer Components

SIDE PANEL COMPONENTS - MASTER MODULE

Component Description
Gas inlet ports 1 - 6 Use to connect up to six analysis gas supplies to the analyzer. When

measuring free space, any one of the portsmay be used for helium.

Side Panel Components

1 - 2 MicroActive ASAP 2460Operator Manual
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BACK PANEL COMPONENTS - MASTER UNIT

Component Description
Ethernet port Use to connect the analyzer to the computer.

Power connector (Not shown.) Located at the bottom of the back panel. Use to con-
nection the power supply.

Power supply switch (Not shown.) Located at the bottom of the back panel. Use to Power
ON or OFF the analyzer. The switch also serves as themain breaker
for the analyzer. This switch automatically powersOFF in the event of
an electrical fault.

RS232 port Use to connect a Smart VacPrep or SmartPrep degassing unit.

Vacuum pump port Use to connect the vacuum pump.

Back Panel Components

1 Analyzer Components
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1 Analyzer Components

EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories can be found online at www.Micromeritics.com.

Equipment Option Description
Chiller Dewar A closed loop recirculating system that utilizes a high surface area

copper coil to provide excellent heat transfer between the dewar and
the recirculating liquids. Log in to your customer portal to access the
Chiller Dewar Quick Start Guide (part number 025-42801-00).

Krypton Option A low surface areamodel includes the addition of a 10 mmHg trans-
ducer and permits accuratemeasurement of very low surface area on
materials such as API (active pharmaceutical ingredient), powdered
metals, etc.

Micropore Option Themicroporemodel includes the addition of amicropore transducer
which extends the low pressuremeasurement capabilities and allows
enhanced performance for characterizingmicroporousmaterials using
nitrogen, argon, carbon dioxide, hydrogen, and other fixed gases. The
micropore transducer also increases pressure resolution in the range
necessary for micropore analysis.

1 - 4 MicroActive ASAP 2460Operator Manual
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DEGASSER OPTIONS

Parts and accessories can be found online at www.Micromeritics.com.

Degasser Option Description
FlowPrep The FlowPrep applies both heat and a stream of inert gas to the

sample to remove adsorbed contaminants from the surface and pores
in preparation for analysis for up to six samples. Choose the tem-
perature, gas, and flow rate best suited for your samplematerial. The
FlowPrep is an independent unit and not controlled by the analyzer.

Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It
contains six sample ports in which up to five temperatures, ramp rates,
and soak times per sample are individually controlled by the analyzer
program so that all degas information is integrated into the sample
data file for future reference. Samples can also be prepared, started,
and completed independently. There is no need to wait for samples on
other ports to finish. Front panel buttons allow aQuickStart operation
with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected to
one computer permitting 24 preparation ports to be used. The Smart
VacPrep is the recommended degassing unit.

VacPrep The VacPrep offers twomethods for removing contaminants. In addi-
tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
parationmethod options best suited to your material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.

Degasser Options

MicroActive ASAP 2460Operator Manual
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1 Analyzer Components

GAS REQUIREMENTS
Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer. Up to five different non-reactive adsorptives— for example, N2,
Ar, CO2, and Kr, plus helium for free space— can be attached to the analyzer simultaneously.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are required.
Pressure relief valves should be set to nomore than 30 psig (200 kPag). All gases should be of a
purity of 99.999% or better. Gas regulators can be ordered fromMicromeritics. Parts and
accessories can be found online at www.Micromeritics.com.

(CGA 580) N2
(CGA 580) He
(CGA 580) Kr

99.999%
99.999%
99.995% (Krypton needed for krypton units only)

CRYOGEN REQUIREMENTS
Liquid nitrogen is used as the cryogen to cool the sample during analysis. A liquid nitrogen transfer
system eliminates the need to pressurize storage dewars. TheModel 021 liquid nitrogen transfer
system is available fromMicromeritics. Log in to your customer portal to access parts and
accessories.
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SPECIFICATIONS FOR ASAP 2460

Specification Description
Electrical

Frequency 50 or 60Hz

Power 800 VA, exclusive of vacuum pumps, which are powered separately

Voltage 100/115/230 VAC (±10%)

Environment
Humidity Up to 90% (non-condensing) for instrument

Temperature 10 to 30 °C, operating
-10 to 55 °C, storing or shipping

Capacity
Analysis
System

2, 4, or 6 sample ports (-1 for krypton), each with a constantlymonitored
saturation pressure port

Analysis System
Manifold
Temperature
Transducer

Type. Platinum resistance device (RTD)
Accuracy. ±0.10 ºC by keyboard entry
Stability. ±0.10 ºC per month

Manifold
Pressure
Transducer(s)

Range: l 0 to 950mmHg operating: 1000mmHgmaximum
l 0 to 10mmHg added for krypton option

Resolution:
l 1000mmHg Transducer: 0.001mmHg
l 10mmHg Transducer *: 0.00001mmHg
l Micropore Transducer**: 0.000001mmHg × full scale

Accuracy:
l 1000mmHg Transducer: within 0.15% of reading
l 10mmHg Transducer *: within 0.15%
l Micropore Transducer**: within 0.12% of reading

Includes nonlinearity, hysteresis, and non-repeatability

* Active only when running krypton samples
** Presented only in the enhancedmicropore option

Specifications for ASAP 2460
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1 Analyzer Components

Specification Description
Sample Port Trans-
ducers and P0 Port
Transducers

Range. 0 to 950mmHg
Resolution. 0.001mmHg
Accuracy. ±0.1% full scale

Vacuum
Transducer

Type. Thermocouple
Range. 0.001 tommHg

Vacuum System
Pumps Nitrogen.Oil-sealed pump

Krypton. MP high-vacuum pump
Oil-free and high vacuum pump. 3.8 × 10-9 ultimate vacuum *
* Ultimate vacuummeasured by pumpmanufacturer according to
Pneurop Standard 5608

Physical
Master Module Height

Width
Depth
Weight

94 cm (37 in.)
38 cm (15 in.)
59 cm (23 in.)
54 kg (119 lbs)

Auxiliary
Module

Height
Width
Depth
Weight

94 cm (37 in.)
38 cm (15 in.)
39.5 cm (15.5 in.)
29 kg (64 lb)

Computer Requirements

l Operating System.Windows 7 Professional or higher operating system is recommended for
the best user experience. For 21CFR11 environments, Windows 10 Professional or Windows
10 Enterprise or higher is required.

l Desktop Installation Required. The application should not be installed on a network drive
with shared access. Multiple users cannot operate the application at the same time.

l 10 Base T or 100 Base T Ethernet Port. If the computer is to be connected to a network, two
Ethernet ports are required. If more than one Ethernet based unit is connected to the same com-
puter (or if a Smart VacPrep is purchased), an Ethernet switch will also be required.

l Read / Write Permissions. All users of the application will need Read/Write permission to all
directories and subdirectories where the application is installed. For 21CFR11 environments,
permissionmay be limited to the installation directory.

l Drives.CD-ROMdrive and USB port.

In keeping with a policy of ongoing product improvement, specifications are subject to change
without notice.
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2 ABOUT THE SOFTWARE

See also:

About the Software in 21CFR11 Environments on page 2 - 30 for CFR11
environments.

The analyzer allows other computer programs to run while an automatic operation is in progress.
TheHelpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own
tab and reflects data collected during the analysis.

TheMicroActive feature offers aWindows interface with an easyway to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can bemanipulated and displayed interactively usingMicroActive reports.

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

TheSetup program is located on the installationmedia and is used to reinstall the software and
make analyzer changes— such as adding or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer, refer
to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP addressmust be 192.168.77.100.

2 About the Software
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2 About the Software

ANALYSIS MODES

The analysis program supports four analysismodes:

l Standard.SeePerform a Sample Analysis on page 6 - 13.

InStandardmode, the system performs nitrogen, or similar gas, analyses at 77 K. All analyses
must use the same gas. Samples can be removed and added to any of the ports without
disturbing the analyses being performed on other ports.

l High Throughput.SeePerform a High Throughput Analysis on page 6 - 16.

InHigh Throughputmode, up to six nitrogen, or similar gas, analyses are started together. All
analysesmust use the same analysis gas and the same Psat gas, whichmay be different from
the analysis gas. Once a set is started, no other samples can be started until the set is
complete. The data collection is done in parallel. Thismode also supportsmeasured
freespace.

l Krypton. SeePerform a Krypton Analysis on page 6 - 17.

InKryptonmode, the analyses are started together. Port 2, 4, or 6 (depending on system
configuration) is used to store Krypton for dosing. The data collection is done sequentially—
one analysis starts and completes before the next is started.

l Micropore.SeePerform a Micropore Analysis on page 6 - 20.

InMicroporemode, up to six analyses are started together. Once a set is started, no other
samples can be started until the set is complete.

Each analysis port is equipped with an elevator that raises and lowers the analysis bath fluid dewar
automatically. A removable shield to enclose the dewar should be used for safety purposes.

The sample saturation pressure (Psat) tube is located next to the sample analysis port. Gas inlet
ports and cable connections are located on the side panel of the analyzer.

The use of isothermal jacketsmaintains a stable thermal profile along the full length of the sample
and Psat tubes.
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MENU STRUCTURE
All program functions use standardWindowsmenu functionality. The title bar contains aUnit [N]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use tomanage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations.Unit 

[n] displays on themenu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access themenu for each installed Smart VacPrep.

Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use tomanage open windows and display a list of open windows. A check-
mark appears to the left of the active window.

Help Provides access to the online operator manual, theMicromeritics web
page, the analyzer web page, and information about the application.

Main Menu Bar Options

Menu Structure
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located inmultiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description
Add Add an item to the list.

Add Log Entry Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically.Autoscalemeans that the x- and y-
rangeswill be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Go toOptions > Default Method to rename this field to something
suitable for your environment. A bar code reader may be used to enter
text into many of the fields on theSample Descriptionwindow. The bar
code reader must be connected to the computer's USB port. To use a
bar code reader, use amouse to click in the field first where
information is to be entered then scan the bar code with the bar code
reader.

If a bar code reader is not used, this alphanumeric field can be used to
enter additional information about the sample, such as a sample lot
number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changesweremade and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Common Fields and Buttons
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Field or Button Description
Comments Enter comments about the sample or analysis. Comments display in

the report header.
Copies Select the number of copies to print. This field is only enabled when

Print is selected.
Delete Whenworking with pressure tables and pressures,Delete removes

the selected information.
Destination Select the report destination.

Edit Whenworking with report parameters, highlight the item in theSelec-
ted Reports list box and clickEdit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes.

Export Exports data in a sample file as a .REP, .TXT, or .XLS file. When
saved to a file, the data can be imported into other applications.

File Select the destination directory. Enter a new file name in the File name
field, or accept the default. Select to save the file as a report system
(.REP), a spreadsheet (.XLS), a portable document format (.PDF), or
an ASCII text (.TXT) file format.

File name Select a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Whenworking with report parameters windows, enter the From and
To range for x- and/or y-axes.

Insert Use to insert one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name TheName column is a list of files in the selected directory or library.

Next Click tomove to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click tomove to the previouswindow.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

Field or Button Description
Print Sends the report to the selected destination (screen, printer, or file).

Remove Remove the selected file or files from the list.

Replace Click to select another file where the valueswill replace the current
file’s values.

Replace All Click to select another .SMP file where the valueswill replace all val-
ues for the active sample file. The original file will remain unchanged.

Report Click to display a window to specify report output options.

Save Saves changes to the active window.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Use to display the data from the current analysis.

Instrument Log. Use to display recent analyses, calibrations, errors,
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.

Common Fields and Buttons (continued)
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selectorwindow, theMicDescription column and theMic Status column display file
description and file status. The File Selector incorporates standardWindows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display amenu of
standardWindows functions.

File Status Description
Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

Entered Sample files containingmanually entered data.

No Analysis Sample files which have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation
but have not been analyzed. This status is applicable only if using
the Smart VacPrep or SmartPrep degasser.

Preparing Sample files that are currently being used in an automatic degas
operation. This status is applicable only if using the Smart VacPrep
or SmartPrep degasser.

File Status

File Type File Name
Extension

Default Location

Alpha-s Curve * .ALS Param directory

Adsorptive Properties .ADP Param directory

Analysis Conditions .ANC Param directory

Degas Conditions .DEG Param directory

Heat of Adsorption Report .HOA Param directory

Methods .MTH Param directory

Report Options .RPO Param directory

Sample Information .SMP Data directory

Sample Tube Properties .STB Param directory

Thickness Curve ** .THK Param directory

File Type, Extension, and Location

File Status, Description, Extension, and Location
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2 About the Software

* Alpha-S Curve file. Saves the relative pressures and resulting quantities adsorbed as an ASCII
text file. These data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative
pressure.

** Thickness Curve file. Saves the relative pressures and corresponding thicknesses as an ASCII
text file. These data are derived by dividing the condensed volume of adsorptive by the selected
surface area. The density conversion factor in the adsorptive properties file is used to convert
quantity adsorbed to volume of condensed adsorptive.

File types available when printing or exporting reports:
Portable document format .PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup language .XML

2 - 8 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



KEYBOARD SHORTCUTS
Shortcut keys can be used to activate somemenu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of themenu item.

Certain menus or functions can also be accessed using theAlt key plus the underlined letter in the
menu command. For example:

l to access the Filemenu, pressAlt + F, then press the underlined letter on the submenu
l Alt + F opens the Filemenu, then pressO to access the File Selector

If the underscore does not display beneath the letter on themenu or window, press the
Alt key on the keyboard.

Field or Button Description
Alt +[Unit n] Opens theUnit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save
changes displays.

Alt + H Opens theHelpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens theReportsmenu.

Alt + V Opens theSmart VacPrepmenu.

Alt + W Opens theWindowmenu.

Shift + F9 Opens the shortcut menu of (1) selected component on analyzer schematic
whenmanual control is enabled or (2) onscreen reports.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selectorwindow.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selectorwindow.

F3 When in the File Selectorwindow, opens the file search box.

F4 When in the File Selectorwindow, opens the address bar.

Keyboard Shortcuts

Keyboard Shortcuts
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2 About the Software

Field or Button Description
F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens theHeat of Adsorptionwindow.

Keyboard Shortcuts (continued)
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OPTION PRESENTATION
Options > Option Presentation

For 21CFR11 environments, seeOption Presentation for 21CFR11 Environments
on page 2 - 13.

Use to change the way sample files and parameter files display:Advanced, Basic, orRestricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option is

used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window similar to theBasic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same passwordmust be entered to
change to theBasic or Advanced display option. This display type is
typically used in laboratories where analysis conditionsmust remain
constant— such as the pharmaceutical industry. TheAdvanced option
is not available at the bottom of the window when using theRestricted
display option.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Show Degas
Conditions

When enabled, displays theDegasConditions tab when using
Advanced option presentation and the DegasConditions drop-down
list when usingBasic orRestricted option presentation. This option
may be deselected to hide theDegasConditions tab if not using a
SmartPrep or Smart VacPrep.

Option Presentation Display

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

The following examples show the same sample file inAdvanced andBasic display.Basic and
Restricted displayswill look the same.

Option Presentation
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2 About the Software

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS
Options > Option Presentation

Presentation Display Description
Show Degas
Conditions

When enabled, displays theDegasConditions tab when using
Advanced option presentation and the DegasConditions drop-down
list when usingBasic option presentation. This optionmay be deselec-
ted to hide theDegasConditions tab if not using a SmartPrep or Smart
VacPrep.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view fromAdvanced (for
Developers) toBasic (for Analysts), click the drop-down arrow at the bottom of the
window. Select either Advanced (when inBasic view) or Basic (when inAdvanced
view).

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic This display option is used after the parameter files have been created

byDeveloper groupmembers. The previously entered or default para-
meter files are then accessible using drop-down lists.

Option Presentation Display

The following examples show the same sample file inAdvanced andBasic display.

Option Presentation for 21CFR11 Environments
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2 About the Software

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.

TheSave button is disabled on sample files with aComplete status. When thePreview button is
used to view reports for sample files with an unsaved status, the report will have aPreview
watermark. TheSave As andPrint buttons on the report window are also disabled.
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LIBRARIES
Options > Manage Libraries

This feature is available only toWindows 7 and higher operating systems.

The library provides an easyway to locate and open specific analyzer files. Libraries are located
within the File Selectorwindow and can be viewed only within the application.

The library gathers sample and parameter files that are stored inmultiple locations— such as folders
on a C: drive, a network location, a connected external hard drive, or a connected USB flash drive—
providing access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items— such as saved searches and search
connectors— cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original file
storage location. However, when deleting files or folders fromwithin a library, they are deleted from
their original file storage location.

Libraries
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2 About the Software

METHODS

Options > Default Method

File > Open > [.MTH File]

For 21CFR11 environments, this section is applicable only to members of the Developer
group, however, members of the Analyst groupmay find information in this section help-
ful. Sample file information that is available to Analysts is created by amember in the
Developer group using information in this section.

AMethod determines the default sample identification format and sequence number. AMethod is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sample file created.

TheMethod drop-down list displays only thosemethods applicable to the open sample file type.
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Field or Button Description
Sequence Number
[text box]

Specify a default numeric string to be used as a prefix in theSample
field when a new sample file is created. This number increments with
each sample file created.

Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol to
have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labelsmay be renamed and the new label becomes a part
of all new sample files.

Default Methods

Methods
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2 About the Software

CONFIGURE THE ANALYZER

UNIT CONFIGURATION

Unit [n] > Unit Configuration

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

Use to display hardware / software configurations, calibrations, and gas selections of the connected
analyzer.

The gases connected to the inletsmust be specified in the analysis program. If the gas is changed on
one of the inlets, the same changemust bemade on theUnit Configurationwindow.

Field or Button Description
Calibrations [button] Displays calibration information for analyzer components.

Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP [button]. Click to display theUnit IP Setupwindow. Use to
change the IP address and subnet mask assigned during installation.
Do not edit these fields unless instructed by aMicromeritics Service
Representative.

Unit Configuration
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Field or Button Description
Board ID [button]. Click to display information from the electronic
circuit boards in the analyzer. These parameters cannot be edited.

Gas Selections
[group box]

Displays ports for gas selections.

Software Versions
[group box]

Displays the software versions of theMIC BIOS, controller, and ana-
lysis program.

Unit Configuration (continued)

UNIT SELECTIONS

Options > Units
Use to specify how data should appear on the application windows and reports. Thismenu option is
not available if usingRestricted option presentation in a standard installation environment.

Unit Selections
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2 About the Software

INSTRUMENT STATUS

SHOW DASHBOARD

Unit [n] > Show Dashboard
The dashboard displays the following:

l Number of analyses completed and started
l Number of days until roughing pumpmaintenance is due
l Manifold outgas rate
l Nitrogen P0 statistics

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically kept
current as the relevant diagnostic data items are updated. The gaugeswill be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right click on the dashboard setting, then clickReset.

Field or Button Description
Analyses
completed / started

DisplaysN/MwhereN is the number of analyses that have finished
data collection andM is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pumpmaintenance is shown. The displayed
value is updated at least once per day and when themaintenance time
is reset. When the displayed value is 30 or less, the value is displayed
in red. Red negative numbers display if maintenance is past due.

Dashboard Gauges
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Field or Button Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when theAnalysisManifold Test is run. See
Start Diagnostic Test on page 9 - 1.

l Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

l At 30%, the left LED turns off.
l At 60%, the center LED turns off.
l At 90%, three green LED lights turn off and the center yellow
LED turns on.

l At 110% and above, only the red LED turns on and attention is
required.

Nitrogen P0 Displays statistics of the saturation pressuresmeasured with nitrogen
gas at liquid nitrogen temperatures. Themean, two-sigma, minimum,
andmaximum values display. The gauge is updated when a P0 is
logged with nitrogen as the adsorptive and a bath temperature of
77±2 K.

Dashboard Gauges (continued)

Show Dashboard
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2 About the Software

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

In 21CFR11 environments, seeSystem Audit Trail on page 2 - 32.

Use to display a log of recent analyses, calibrations, errors, or messages.

Field Description
Add Log Entry [button] Use to enter information to appear in the sample log report that cannot

be recorded automatically through the application. Click the button
again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select print destination and report start date.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Instrument Log

2 - 22 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

Show Instrument Schematic
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Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. Whenmanual control is
disabled, closed valves appear white.
Servo Valve. Closed.

Servo Valve. Open.

Elevator.

The arrow inside the dewar icon indicates the direction of dewar move-
ment.

The elevator icon indicates the position of the dewar.

Sample Tube.Cannot bemanually controlled.

P0 (Psat) tube.

Transducers Each sample port and P0 port contains a 1000mmHg transducer. The
transducer readings display next to the ports.

Displays the temperature, the 1000mmHg,
10 mmHg transducer readings, and vacuum gauge
pressure.

The 10mmHg transducer (for krypton or Micropore
installations).

Analyzer Schematic Icon Table

Show Instrument Schematic
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2 About the Software

Icon or Symbol Description

Displays themicropore transducer reading. This
transducer is optional and is shown only if installed.

Analyzer Schematic Icon Table (continued)

Valve Description
1 through 6 Sample ports

7 Lower manifold isolation

8 Sample ports unrestricted vacuum

9 P0 ports access

10 P0 ports unrestricted vacuum

11 through 16 P0 ports

17 Upper manifold isolation

18 Gas inlets unrestricted vacuum

21 through 26 Gas inlet port valves

Unmarked Servo

A Micropore transducer

B Vacuum gauge

C 10mmHg transducer

D 1000mmHg transducer

E Analysismanifold temperature

F Servo valve

G Sample tube

H Elevator

I P0 tube

Analysis Valve Descriptions
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Instrument Schematic Shortcut Menus

Schematic Shortcut
Icon Description

Valve options Close.Closes the selected valve.

Open.Opens the selected valve.

Pulse.Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

For Servo valve:

l Set. Use to set the servo valve target pressure and dose or evac-
uate.

l Close.Closes the servo valve. The valve symbol changes to solid
black.

Elevator options Right click the elevator icon, then select:

Raise. SelectRaise to raise the elevator. When it ismoving, press the
keyboard space bar to stop themovement (or right click and select
Stop from themenu).

Lower. Select Lower to lower the elevator. When it ismoving, press
the keyboard space bar to stop themovement (or right click and select
Stop from themenu).

Stop.Stops the elevator frommoving.

Schematic Shortcuts

Show Instrument Schematic
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SHOW STATUS

Unit [n] > Show Analysis Status
Use to show the current status for each port.
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CONVERT FILES
File > Convert > [*.MGD file]

l Converts sample files created with an ASAP 2400, ASAP 2405, or ASAP 2420 system to files
compatible with the ASAP 2460 system.

l Converts StarDriver files (.MGD extension) to a sample file with a .SMP file extension. Only those
files with a .MGD file extension display in theName column.

EXPORT FILES
File > Export

See also:

Exported Data Example on page C - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or to a file. Data can be exported as a .PDF, .REP, .TXT, .XML, or .XLS file format.
The type of data to include or exclude can be selected during the export process.When exported to a
file, the data can be imported into other applications that read these file formats.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the file
was created or last edited, file identification, and file status.

Select one or more files from the file selector, then clickList.

Convert Files
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ABOUT THE SOFTWARE IN 21CFR11 ENVIRONMENTS

See also:

Option Presentation for 21CFR11 Environments on page 2 - 13

TheMicromeritics Confirm applications for 21CFR11 environments require an
operating system ofWindows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed inWindowsUsers andGroups.

TheMicromeritics Confirm application enables laboratorymanagers to develop analysismethods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_confirm_user mic_confirm_user is the user name used by all installations.

l This user should have complete control over the installation dir-
ectory.

l The application is launched under this user name and has this
user’s privileges to the windows file system.

l This user should not be used by anyone or any other software that
is not aMicromeritics application.

l The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.

Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the Developer
group:

l have rights to all functions of theMicromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.
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Confirm Group Name Description

l can run an analysis.
l can also be assigned Administrator rights which control the user pro-
files.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst group:

l have access to the Basic presentation option only.
l may create sample files from pre-definedmethods and canmodify
only a limited number of input fields.

User Permissions
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CREATE NEW FOLDER
File > Create New Folder

For 21CFR11 environments only.

Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT administrator configuresWindows permissions.

SYSTEM AUDIT TRAIL

For 21CFR11 environments only.

File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changesmade to sample files.

Contains an audit trail of all system initializations, user login attempts, and sample analyses.
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SOFTWARE UNINSTALL
When the software is uninstalled using uninstall.exe, only the files required to run the application are
removed. Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.exe file located in the software installation
directory, then follow the prompts.

UNINSTALL IN A 21CFR11 ENVIRONMENT

In a 21CFR11 environment, upon uninstalling the Confirm application, the system
administrator should go intoWindowsUsers andGroups to remove the Confirm users
and groups. See the Confirm Administrator Guide (part number 004-42821-01).

Depending on the network, Windowsmay not allow the uninstall.exe program to run. If this happens.
follow these steps:

1. InWindowsUsers andGroups, verify that the current user is not amember of the analyst
group or developer group. If so, remove the user from the group(s). LogOFF, then log back
ON to the computer.

2. InWindowsExplorer, in the Confirm installation directory, double-click the uninstall.exe file to
run the uninstall program.

SOFTWARE UPDATES
Log in to your customer portal to access and download the latest analyzer software version.

When performing a software update, existing data files are not overwritten. There are three types of
subsequent installation:

l a later version than the current installation
l the same version as the current installation
l an earlier version than the current installation

Insert the setupmedia into themedia drive. The setup program starts automatically. If the program
does not start automatically, navigate to the installationmedia drive, locate and double click the
setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groupsmust bemade usingWindows
Users andGroups.

Software Uninstall

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 2 - 33

http://www.micromeritics.com/Customer-Login.aspx




3 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options andmay be
displayed in either Advanced, Basic, orRestricted presentation displaymode. SeeOption
Presentation on page 2 - 11 orOption Presentation for 21CFR11 Environments on page 2
- 13.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example— if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

3 About Sample Files
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3 About Sample Files

CREATE SAMPLE FILES
File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the Developer
group, however, members of the Analyst groupmay find information in this section help-
ful. Sample file information that is available to Analysts is created by amember in the
Developer group using information in this section.

Each analysismust be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the default display option by selectingOptions > Option Presentation or select
Basic or Advanced from the drop-down list at the bottom of the window.

Sample filesmust be initially created inAdvanced option presentation. After the sample files are
saved, the files are accessible inBasic andRestricted option presentation.

The values specified in the parameter portions of the default method are the defaults for new sample
files. To navigate from one set of parameters to another, select the parameter tab across the top of
the window.

Sample Tube parameters are edited on theSample Description tab.
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A bar code reader may be used to enter text into many of the fields on theSample
Descriptionwindow. Use amouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Field or Button Description
Add Log Entry [button] Use to enter information to appear in the sample log report that cannot

be recorded automatically through the application. Click the button
again to enter multiple log entries.

Comments [text box] Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box] If mass = 1, the reported surface area equals the total surface area but
it is always shown asm2/g. If an accuratemass is entered, the repor-
ted surface area is normalized per gram of sample. Choose whether to
enter massmanually or have the system automatically calculatemass.
Enter a value for samplemass. Mass can be changed any time before,
during, or after analysis.

Enter.Enables theSamplemass field. Enter a value for the sample
mass.

Calculate.Enables theEmpty tube andSample + tube fields. Enter
the values necessary to calculate the samplemass. Equation used to
calculate samplemass:

Masssample = Masssample+tube –Masstube

Density.Value is used for the calculated free spacemethod only. Use
0.000 for a blank analysis.

Method [drop-down box] Select amethod from the drop-down list.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Sample [text box] Enter a sample description.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or clickEdit to
modify or create a new sample tube file.

Submitter [text box] Enter submitter identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Sample Files

Create Sample Files
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3 About Sample Files

Field or Button Description
Type of Data
[group box]

Automatically collected.Select if the type of data will be
automatically collected by the systemwhile an analysis is running.

Manually entered.Use to enter datamanually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in theBasic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 7.
User Parameters
[group box]

These fields are primarily used for the SPC (Statistical ProcessCon-
trol) reporting to specify sample characteristics or itsmanufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SummaryReport. Some fieldsmay not display (or may have a dif-
ferent field label) if modified in themethod fromwhich the sample file
was created, either through Options > Default Method or File
> Open > Method. SeeSPC Report on page 7 - 4.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Sample Files (continued)
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

Whenworking with an existing sample file, consider making a copy of the sample file to
maintain the original configuration options.

File Status Displays
Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

Open a Sample File
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3 About Sample Files

If a sample file with aComplete status is opened, to return to the tabbed file editor, selectAdvanced
or Basic from the drop-down at the bottom of the window.

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.
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MANUALLY ENTER DATA

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

This process allows themanual entry of pressure data from a sample file with aComplete status.
There are twomethods for manually entering data into a sample file:

l Copy and paste onto the graph area of the interactive window
l Import data into the interactive window

COPY AND PASTE MANUALLY ENTERED DATA
1. Open a sample file with aComplete status. The file will open to the interactive reports window.
2. Right click in the graph area of the interactive reports window, then selectCopy data.

3. Open another sample file usingAdvanced option presentation.
4. On theSample Description tab, selectManually entered in the Type of Data group box.
5. Click theAdvanced down arrow at the bottom of the window, then select Isotherm.

Manually Enter Data
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3 About Sample Files

6. Ensure that all parameter fields are set appropriately, then clickPaste.
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IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Datamust be in two columns and separated by a comma or white-space. Acceptable column
headings are:

l Relative Pressure
l Absolute Pressure (mmHg)
l Absolute Pressure (kPa)
l Absolute Pressure (mBar)
l Quantity Adsorbed (mmol/g)
l Quantity Adsorbed (cm³/g STP)
l Quantity Adsorbed (cm3/g STP)

Sample Physical Adsorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793

Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
0.152718 54.2336
0.103389 49.5803

Manually Enter Data
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3 About Sample Files

To import the ASCII text file

1. Open a new sample file inAdvanced option presentation.
2. On theSample Description tab, selectManually entered.
3. Click theAdvanced down arrow at the bottom of the window, then select Isotherm.

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an error

message appears instead, verify that the .TXT file format is correct.
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4 PARAMETER FILES

In 21CFR11 environments, this section is applicable only to members of the Developer
group, however, members of the Analyst groupmay find information in this section help-
ful. Parameter file information that is available to Analysts is created by amember in the
Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example— if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

Methods include both analysis conditions and report options, offering themost convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed or new
parameter files can be created.

The following file types can exist as part of the sample file aswell as individual parameter files:

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
(or clickEdit next to theAdsorptive selection on theAnalysis Conditions tab when inAdvanced
option presentation)

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Field or Button Description
Adsorbate molecular
weight [text box]

Themolecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Adsorptive [text box] Name of the adsorptive gaswhose properties are being defined.

Density Conversion
Factor [text box]

Factor determined by obtaining the ratio of the gas density (STP) to
the liquid volume. This field is disabled ifNon-condensing Adsorptive is
selected.

Adsorptive Properties
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Field or Button Description
Dosing Method
[group box]

Normal.Dose from a pressurized tank of gas attached to a gas inlet
port.

From last sample port. For krypton analysis only, the krypton is
stored and dosed on the last port (2, 4, or 6 depending on system
configuration).

l Charge from inlet.Use to have the tube automatically charged
with condensate from a gas inlet port after the dewar is raised.

l Purify adsorptive.Use to have the condensate in the tube purified
after charging by evacuating the gas over the condensate. If
Charge from inlet is selected, selectPurify adsorptive to have non-
condensing contaminants automatically removed from the dosing
tube prior to analysis. After the adsorptive has condensed in the
Psat tube or sample port, the remaining gas in the tube will be evac-
uated to remove noncondensing contaminants. A small amount of
the purified adsorptive condensate will then return to gas phase to
restore equilibrium pressure in the tube.

Maximum manifold
pressure [text box]

The highest pressure to which themanifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925mmHg. Low pres-
sure sourceswill require lower numbers. For gases to be used for dos-
ing after charging a tube from a gas inlet, enter themaximumpressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box] Enter themnemonic name for the adsorptive. If this gas is connected
to a gas inlet port, thismnemonicmust be entered in theUnit Con-
figuration GasSelection for the inlet port. SeeUnit Configuration
on page 2 - 18

Molecular cross-sec-
tional area [text box]

The area that a single adsorbedmolecule occupies on the surface of
the sample. It is used in surface area calculations.

Non-condensing
Adsorptive [check box]

Select if using a non-condensing analysis gas.When selected, the
Density conversion factor field and thePSAT vs T button are dis-
abled.

Non-ideality factor
[text box]

Compensates for the forces of attraction betweenmolecules in a real
gas. This value is used for a calculated free space.

Psat vs T [button] Click to edit thePsat vs Temperature table. The table contains sat-
uration pressures and their corresponding temperatures. To edit, click
in a field and enter the value.

Adsorptive Properties (continued)

Adsorptive Properties
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4 Parameter Files

Field or Button Description
Therm. tran. hard-
sphere diameter
[text box]

An estimate of molecular size used in calculating the thermal
transpiration correction.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Adsorptive Properties (continued)
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ANALYSIS CONDITIONS
File > Open > [.ANC File]
(or click theAnalysis Conditions tab when inAdvanced option presentation)

Analysis conditions specify the parameters used to guide an analysis.

Field or Button Description
Absolute pressure dosing
[check box]

Specifies pressure targets in mmHg, mbar, or kPa instead of rel-
ative pressure. If this option is selected, theRelative Pressure
labels and entries change toAbsolute Pressure in the selected
pressure units. This option is typically selected when using
adsorptives at analysis conditions above the critical point of the
gas; for example, H2 adsorption on carbon at liquid nitrogen
temperature.

Adsorptive
[drop-down box]

Select anAdsorptive Properties file from the list of defined
gases to be used for analysis. After selection, clickEdit to
modify adsorptive properties. SeeAdsorptive Properties on
page 4 - 2.

Analysis Conditions

Analysis Conditions
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4 Parameter Files

Field or Button Description
Analysis Conditions
[drop-down box]

Use to browse for anAnalysis Conditions file that contains ana-
lysis condition parameters to be used in the analysis.

Backfill [button] Select gas for backfilling the sample tube at the start and end of
an analysis.

The options are disabled if the file status isEntered,Complete,
or Analyzing.

Dose Increments
[selection]

The sample is dosed repeatedly with a fixed amount of gas and
isotherm points are collected after equilibrating each dose.

Options [button]. Each entry in the table defines how much to
dose for a segment of the isotherm. In this form of dosing, there
is no predefined pressure table. Define target ranges for up to
10 dose increments. The ending relative pressure and the dose
amount (entered or as the fraction of the previous quantity
adsorbed) for each target range are shown.

Analysis Conditions (continued)
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Field or Button Description
Equilibration [button] Provides options to specify the equilibration interval and delay

time.

Minimum equilibration delay at p/po > = 0.995. The
minimumnumber of seconds required before equilibration can
occur for a relative pressure greater than or equal to 0.995. This
field is not available if Absolute pressure dosing is selected on
theAnalysis Conditions tab.

Relative Pressure (p/po) or Absolute Pressure. The
pressure the equilibration interval will be applied.

Free Space [button] Use to enter the free spacemeasurement type.

Measure:

l Lower dewar for evacuation. If the dewar is to be
lowered for evacuation, select this option and enter the
length of time for evacuation after the free spacemeas-

Analysis Conditions (continued)
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Field or Button Description

urement in theEvacuation time field. If using a cryostat, the
operator must manuallymove the cryostat assembly when
prompted.

l Evacuation time. The length of evacuation time prior to
free spacemeasurement.

l Outgas test. Checks for system leaks or sample out-
gassing. After free space ismeasured, the dewar is lowered
and the sample evacuated for the specified amount of time.
The leak test is performed after evacuation. If the pressure
risesmore than 0.025mmHgwithin the time specified in the
Outgas test duration field, outgassing is present. If a leak is
found, the leak test repeats nine times, with 30minutes evac-
uation between tests. If the 10th leak check fails, the analysis
stops and the operator is notified. While leak testing slightly
increases analysis time, it prevents the continuation of ana-
lysis and collection of erroneous data if a leak occurs.

Enter.Measures free space after analysis ends. Enter the
estimated free spacemeasurements.

l Ambient free space. Empty sample tube gas capacity
measured at room temperature.

l Analysis free space.Empty sample tube gas capacity
measured with the dewar raised.

Calculate.Use to have the free spacemeasurement
calculated using the sample and tube parameters.

Options [button] Available when the Target Pressures option is selected.

First Pressure Fixed Dose.

This option ismost frequently used when performing a

Analysis Conditions (continued)
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Field or Button Description
standard nitrogen analysis of mesoporousmaterials such as
catalysts. If the first pressure table point is low and the gas
uptake of the sample is expected to be high, this option can
shorten the time required to reach the first point on the
pressure table.

The sample is dosed repeatedly at low pressureswith a
specified amount of gas until the first pressure point is
reached. This initial dosing quicklymeets the adsorptive
demand of the sample.

The first point on the pressure table is the threshold value.
Once this first pressure point is reached, points are
equilibrated and recorded in accordance with the specified
pressure table.

Enter the amount of gas to be added to the sample for each
dose cycle.

Maximum volume increment.

Select to determine when additional data points are
collected between target pressures in regions of adsorption.
When themaximum increment has been adsorbed since the
last collected data point, another point is equilibrated and
collected. During desorption, this field is treated as a
maximum volume decrement value.

When using this option, reaching pressure points exactly is
not important; therefore, the tolerances should be set
relatively large (10mmHg and 10% or so) for proper
functioning of the algorithm. The pressure table should also
have several points scattered over the region of interest.

This field is disabled if First pressure fixed dose is selected.

Absolute / Relative pressure tolerance.

Values used to determine how close the actual pressure
must be to each target pressure from the pressure table. At
lower pressures, the relative tolerance value is lower. At
higher pressures, the absolute tolerance value is lower.

Experiment 1. Theremight be an absolute tolerance of

Analysis Conditions (continued)
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4 Parameter Files

Field or Button Description
5 mmHg, a relative tolerance of 5%, and a target pressure of
40 mmHg; 5% of 40 mmHg is 2 mmHg. Since 2 mmHg
(relative tolerance) is lower than 5 mmHg (absolute
tolerance), 2 mmHg is used. Therefore aminimumpressure
of 38 mmHg (40 - 2) must be attained to collect data for a
target pressure of 40 mmHg.

Experiment 2. Theremight be an absolute tolerance of 5
mmHg, a relative tolerance of 5%, and a target pressure of
200 mmHg; 5% of 200 mmHg is 10 mmHg. Since 5 mmHg
(absolute tolerance) is lower than 10 mmHg (relative
tolerance), 5 mmHg is used. Therefore aminimumpressure
of 195mmHg (200 - 5) must be attained to collect data for a
target pressure of 200 mmHg.

Normally, surface areameasurement points are widely
spaced and the resultingmeasurement is not very sensitive
to the precise location of points so wider tolerancesmay be
used. Unnecessarily tight tolerances lengthen the analysis.

Low Pressure incremental dose mode.

Select when performing an analysis of microporous
materials. At low pressures on Type 1 isotherms, the
pressure points are very closely spaced, making a useful
pressure table difficult to define. When enabled, equilibrium
points aremeasured at approximately equal intervals on the
quantity adsorbed axis. Each dose is fully equilibrated and
recorded as a data point.

In thismode, the sample is successively dosed with a
specified amount of gas until the first pressure point is
reached. The first point is the threshold value, triggering the
transition from Incremental DoseMode toPressure Table
Mode. When the first pressure table value is reached,
Incremental DoseMode is disabled, and points are recorded
in accordance with the specified pressure table. Because
the data points recorded during Incremental DoseMode
may definemost of the analysis, one point on the pressure
table can be sufficient and serve as the end point for the
analysis.

l Dose amount. The amount of gas to be added to the

Analysis Conditions (continued)

4 - 10 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



Field or Button Description

sample for each data point until the first point on the pres-
sure table is reached. This field is enabled when Low
pressure incremental dosemode is selected.

l Equilibration Delay.Enabled when Low Pressure incre-
mental dosemode is selected.

Minimum. Prevents premature equilibration caused by
reduced percentage sensitivity to pressure changes at
the lowest pressures.
Maximum. Prevents the effects of long term
temperature or pressure drift, whichmay cause the
analyzer to wait an excessive length of time for
equilibration.

p° and T [button] Click to select one option for obtaining the saturation pressure
(Po) and analysis bath temperature. Each selected option
presents a different set of parameters at the bottom of the
window.

Options and descriptions:

1. Analysis bath temperature (not used for krypton ana-
lyses). Measures the p0 on a continuous basis. Allows
themeasurement of each data point without slowing the
analysis.

2. Analysis bath temperature (not used for krypton ana-
lyses). Measures the p0 on a continuous basis and over
the sample, then adjusts themeasured p0 in the sample
tube to agree with the p0 over the sample.

3. The p0 and analysis bath temperatures or an analysis

Analysis Conditions (continued)
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Field or Button Description
bath temperature only (whenAbsolute pressure dosing
is selected on theAnalysis Conditionswindow). This
method uses the entered values.

4. Psat gas. If this is a krypton analysis, select theNitrogen
@ 77.35K option from theAdsorptive drop-down box.
ClickPsat vs T to edit the values of the Psat vs T table.
Editing the values in the current table does not affect the
original table.

5. Analysis bath temperature.Analysis bath temperature
and an estimate for the initial p0 (not used for krypton ana-
lyses). Measures the p0 over the sample. After the p0 is
measured, the value is reapplied to all data points.

6. Analysis bath temperature. Thismethod calculates
the p0 at the time of analysis using the entered tem-
perature.

If From last sample tube (for krypton analysis) on
the analysis window and a p0 option other than 3,
4, or 6 is selected, an error message is displayed
when the analysis begins.

Preparation [button] Use to enter analysis preparation details.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary
evacuation which takes place prior to the free space
measurement or sample analysis if free space is to be entered
or calculated.

Fast Evacuation.Select for samples (such as pellets) that do
not fluidize or shed particles during evacuation.

Analysis Conditions (continued)
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Field or Button Description
Leak Test.Enables the system to check for leaks or sample
outgassing before the analysis. The leak test allows sample
pressure to rise during the test. If the pressure risesmore than
0.15mmHg, the analysis does not proceed and the operator is
notified. While leak testing slightly increases analysis time, it
prevents the continuation of analysis and collection of
erroneous data if a leak exists. Select to enable the Leak test
duration field.

Leak test duration.Enter the duration of the leak test.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast
evacuation is not selected.

Use TranSeal.Select if using the TranSeal to transfer the
sample from the preparation port to the analysis port under
vacuum.

Pressures [button] Available when the Target Pressures option is selected. Use to
edit theEntered Pressures table.

The pressure table consists of relative pressure points at which
isotherm data are to be collected. An optional pressure
increment can be entered in thePressure Increment column,
which will cause additional points to be collected at intervals of
the pressure increments up to the relative pressure specified in
theEnding Pressure column.

Analysis Conditions (continued)
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Field or Button Description
The relative pressure pointsmay span the entire range of
0.000000000 to 0.000000001 p/p0. Theremust be one
adsorption branch (strictly increasing pressures) followed
optionally by one desorption branch (strictly decreasing
pressures).

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Analysis Conditions (continued)
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DEGAS CONDITIONS
File > Open > [.DEG File]
(or click theDegasConditions tab when usingAdvanced option presentation)

Use this option only when the SmartPrep or Smart VacPrep is installed. Degassing is a
required step in preparation for an analysis. TheDegasConditions tab provides settings
that will be automatically applied during the degassing procedure when using the Smart
VacPrep.

Log in to your customer portal to access the Smart VacPrepOperator Manual.

Field or Button Description
Copy QuickStart Degas
Conditions from
Smart VacPrep unit
[drop-down box]

Use to copy the degas conditions settings from the selected Smart
VacPrep unit and port.

Degas Conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Degas Conditions

DegasConditions
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Field or Button Description
Heating Phase [table] This option is applicable when degassing with either a Smart VacPrep

or a SmartPrep.

Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time.How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation [group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate.Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with theHeating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure.Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below theHold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate.Rate at which the temperature is to change
when advancing to the target pressure.

Unrestricted evac. from.Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Degas Conditions (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click theReport Options tab when inAdvanced option presentation)

See also:

l About Reports on page 7 - 1
l Selected Reports on page 8 - 1

Log in to your customer portal to accessMicroActive Report Tutorials and the Calculations
document.

Additional reports are available using theReportsmenu.

Use to specify report options for data collected from an analysis or manually entered data.Report
Options files also help in customizing report details such as axis scale, axis range, column headings,
and components of thickness curve equations. These filesmay contain tabular reports, plots, or
both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options filesmay be defined to include overlay options. This system allows the overlay of up
to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a different
plot type from the same analysis. SeeGraph and Sample Overlays on page 7 - 26.

Report Options

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 4 - 17

http://www.micromeritics.com/Customer-Login.aspx


4 Parameter Files

Field or Button Description
Apply thermal tran-
spiration correction
[check box]

Use to correct the temperature-induced pressure difference between
themanifold and the chilled sample tube. This option ismost significant
for pressures less than approximately 1.0mmHg. Do not use filler rods
in the sample tube when applying correction for thermal transpiration.
Always use thermal transpiration when performingmicropore
analyses.

Inside diameter of sample tube. Enabled whenApply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

See the Thermal Transpiration Correction section of theCalculations
document. Log in to your customer portal to access theCalculations
document.

Overlays [button] SeeGraph and Sample Overlays on page 7 - 26.

Report Options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report. For BJH reports, BJH
pore dimension can be calculated in pore width (w), pore radius (R), or
pore diameter (D). Go to Options > Units to specify default
calculations.

Show graphic [text box] Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Report Options

4 - 18 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018

http://www.micromeritics.com/Customer-Login.aspx


SAMPLE TUBE
File > Open > [.STB File]
Sample Tube files specify information about the sample tube.

Field or Button Description
Ambient free space
[text box]

Empty sample tube gas capacitymeasured at room temperature.

Analysis free space
[text box]

Empty sample tube gas capacitymeasured with the dewar raised.

Load from Sample File
[button]

Loads parameters from the selected sample file.

Non-ideality factor
[text box]

Compensates for the forces of attraction betweenmolecules in a real
gas. This value is used for a calculated free space.

Sample tube
[drop-down box]

It is a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in theSample Tube drop-down list on theSample Description tab.

Use filler rod
[check box]

Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 squaremeters of total surface area.

Sample Tube

Sample Tube
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4 Parameter Files

Field or Button Description
Use isothermal jacket
[check box]

Select if an isothermal jacket is to be used. An isothermal jacket main-
tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type
[group box]

Select the seal type to be used.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Sample Tube (continued)
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5 DEGASSING
Most solid materials absorbmoisture and other contaminants when exposed to the atmosphere. The
samplemust be clean when an analysis is performed. The degas process heats the sample with an
inert gas flowing over it to remove themoisture and contaminants.

Log in to your customer portal to access the Smart VacPrepOperator Manual or the SmartPrep
Operator Manual.

DEGAS ON THE SMARTPREP

See:

Degasser Options on page 1 - 5

If a SmartPrep is not connected to the analyzer, the SmartPrepmenu items are not
available.

Log in to your customer portal to access the SmartPrepOperator Manual.

SMARTPREP CONFIGURATION
Unit [n] > Degas > SmartPrep Configuration
Displays the SmartPrep configuration and software versions.

5 Degassing
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5 Degassing

SHOW SMARTPREP STATUS
Unit [n] > Degas > Show SmartPrep Status
The SmartPrep Statuswindow allows themonitoring of degas operations and to stop the gas flow
after samples are degassed.

Button Description
Cancel [button] Discards any changes or cancels the current process.

Set Temperature
[button]

Use to set the temperature of the selected port.

Skip [button] Use to bypass the current stage.

Stop Gas flow [button] Stops the gas flow to the selected port.

Show SmartPrep Status
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START SMARTPREP DEGAS
Unit [n] > Degas > Start SmartPrep Degas
The six SmartPrep heating stations are represented by row numbers on theAutomatic Degas
window.

Button Description
Browse [button] Searches for a file.

Cancel [button] Discards any changes or cancels the current process.

Clear [button] Clears the sample file selection for a port.

Start [button] Starts degassing.

Start SmartPrep Status

Degas on the SmartPrep
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5 Degassing

DEGAS ON THE SMART VACPREP

See:

Degasser Options on page 1 - 5

Log in to your customer portal to access the Smart VacPrep operator manual.

TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT

See also:

Worksheets on page F - 1

The sample tubemust be removed from the degas port, weighed, and then installed onto the
analysis port for analysis.

If the sample tube will not bemounted on the analysis port immediately, leave it on the
degas port. If it is necessary to remove the sample tube and a Seal Frit was not used,
insert a rubber stopper into the sample tube.

1. Allow the sample tube to cool.
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Do not touch the sample tube or the heatingmantle until they have reached room tem-
perature. Touching the sample tube, heatingmantle, or heatingmantle clip before they
have cooled could result in burns.

2. Carefully remove the heatingmantle clip and the heatingmantle from the sample tube.
3. Hold the sample tube, loosen the port connector nut, and remove the sample tube from the

degas port.
4. Remove the connector nut, ferrule, andO-ring from sample tube stem.
5. Weigh the sample tube set. Use theSample DataWorksheet to determine the samplemass.
6. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube

bulb.
7. Place the connector nut, ferrule, andO-ring onto the sample tube stem.
8. Remove the stopper and immediately attach the sample tube to the analysis port, pushing it

fully up into the port. Secure it in place by screwing the connector nut onto the analysis port
connector; hand tighten the connector nut. If a Seal Frit was used, it does not have to be
removed.

9. Place the dewar cover over the sample tube stem just above the isothermal jacket.

Transfer a Degassed Sample to an Analysis Port
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5 Degassing

EVACUATE PORTS
Unit [n] > Evacuate Ports

Field or Button Description
Port[s]
[group box]

Select the ports to evacuate.

Fast evacuation Unrestricted evac. pressure.Pressure at which the unrestricted
evacuation is to begin.

Evacuation rate. Rate at which unrestricted sample evacuation
should begin.

Vacuum setpoint. The vacuum level to be achieved before timed
evacuation begins.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Evacuate Ports
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6 PERFORM AN ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to start
an analysis. Once the analysis window is opened, manual control is disabled until the
analysis has completed. During analysis, pausing and resuming is allowed, however,
steps cannot be skipped.

DEWAR PRECAUTIONS

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Do not pour liquid nitrogen directly into a sink. Doing somay cause drain pipes to burst.

When handling dewars containing liquefied gases or cryogenic liquids:

l Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

l When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

l Use a plastic stirring rod when stirring substances in a dewar containing liquefied gases (or other
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a
protective coating.

l Do not handle heavy objects above the dewar. If unavoidable, place a protective cover over the
dewar opening. If an object of sufficient weight is accidentally dropped into the dewar, shattering
may occur.

l If the dewar has a protectivemesh covering, do not remove it. This cover minimizes the risk of fly-
ing particles should the dewar be knocked over, dropped, or broken.

6 Perform an Analysis
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6 Perform an Analysis

PREPARE FOR ANALYSIS
The steps in this topic properly prepare the equipment for an analysis. It is recommended to perform
the tasks in the provided order.

See also:

l Dewar Precautions on the previous page
l Select a Sample Tube on the facing page
l Step 1 -Clean and Label Sample Tubes on page 6 - 4
l Step 2 -Create the Sample File on page 6 - 6
l Step 3 -Determine the Sample Mass for Physical Adsorption on page 6 - 6
l Step 4 -Degas the Sample on page 6 - 8
l Step 5 - Sample Tube Installation on page 6 - 9
l Step 6 - Fill and Install the Dewar on page 6 - 11
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SELECT A SAMPLE TUBE

A sample tube set consists of:

l Sample tube
l Stopper or Seal Frit
l Filler rod

Standard sample tubes for the analyzer have a 1.27 cm (1/2 in.) outside diameter (OD). Stepped
ferrules, smaller O-rings, isothermal jackets, and filler rods are available for adapting the smaller
stems to the degas or analysis ports. The stem diameter selected for use is amatter of accuracy and
precision requirements, as well as personal preference and convenience in loading the sample.

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended for
1.27 cm (1/2 in.) OD sample tubes.

Filler rods help to ensure accuracy in sampleswith lower total surface areas by reducing the free
space volume. It is generally a good practice to use filler rods for samples having less than 100
squaremeters of total surface area. Filler rods are unnecessary for sampleswith total surface areas
greater than 100 squaremeters.

Filler rods can interfere with thermal transpiration correction and, therefore, should not
be used when performingmicropore analyses.

The weight of the empty sample tube should be determined after it has been cleaned, degassed, and
filled with backfill gas. The sample tube should be allowed to cool to room temperature before
backfilling. After the sample tube has cooled, remove it from the degas port and weigh it.

If a Seal Frit is not used, insert a stopper immediately after removing the sample from
the degas port.

Themass of the isothermal jacket may vary slightly and cannot be considered as constant; therefore,
do not weigh it with the sample tube set.

Select a Sample Tube
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6 Perform an Analysis

CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

Sample tubes and filler rodsmust be clean and dry before samples are added and weighed. The
following table indicateswhichmaterials are supplied byMicromeritics and which are supplied by the
user. The procedures following thematerials table are recommended.

Supplied by Micromeritics Supplied by User

l Filler rod
l Funnel
l Sample data worksheet
l Sample tube
l Sample tube brush
l Sample tube rack
l Sample weighing support
l Stopper for sample tube

l Acetone or isopropyl alcohol
l Analytical balance
l Detergent (such as Alconox)
l Drying oven
l Forceps
l Insulated gloves
l Pipe cleaners
l Rubber gloves or lint-free cloth
l Safety glasses
l Ultrasonic cleaning unit
l Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500mL of warmwater and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubeswith warmwater and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.
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5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubeswith the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the
rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10minutes under heat. If using thismethod, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube is
installed on the analysis port.

Clean and Label Sample Tubes
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6 Perform an Analysis

10. Blow out the sample tubeswith oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.

CREATE THE SAMPLE FILE

See:

Create Sample Files on page 3 - 2

DETERMINE THE SAMPLE MASS FOR PHYSICAL ADSORPTION

See also:

Sample Data Worksheet for Gas Adsorption on page F - 2

Clean, dry sample tubes are essential for accurate results. How much sample to use can be
determined best by experiment. In general, a sample providing 40 to 120 squaremeters of total
surface area is recommended for nitrogen analysis. Less than 40 squaremetersmay cause
unreliable results. More than 120 squaremeters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total weight. Proper weighing techniques aremost important in this case. Use no less than 100mg to
reduce the effect of weighing errors.

Care should be taken when loading powders— the accessory funnel is useful for this purpose.
Large granules or chunksmay be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is important
the true samplemass be known.

Follow the instructions on theSample DataWorksheet and complete all fields to find the true sample
mass.

1. Record the sample tube identification on theSample DataWorksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at

zero (0).
3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing

support and place it on the balance.
4. Record the stabilizedmass on theSample DataWorksheet . Remove the sample tube set

from the balance.
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Do not touch the sample with bare handswhile performing the following steps. Doing so
could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero (0).
6. Slowly pour the specified amount of sample into the sample container.
7. Remove either the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube.

9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. On theSample DataWorksheet, record the following:

a. Mass of the sample tube set with the sample.
b. Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.

Determine the SampleMass for Physical Adsorption
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6 Perform an Analysis

DEGAS THE SAMPLE

See also:

l Degas Conditions on page 4 - 15
l Degassing on page 5 - 1
l Sample Data Worksheet for Gas Adsorption on page F - 2

If using the Smart VacPrep degasser, go toSmart VacPrep > Unit [n] > Start
Degas, then degas the sample usingmenu commands and information entered on the
DegasConditions tab. Log in to your customer portal to access the Smart VacPrep
Operator Manual.

For instructions on degassing on the SmartPrep, seeDegas on the SmartPrep on
page 5 - 1.

After the sample has been weighed, use a degassing unit to remove any contaminants whichmay
have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample. Record themass on theSample Data
Worksheet for Gas Adsorption on page F - 2 asMass of Sample tube set plus sample
(After Degas).

2. Subtract theMass of empty sample tube set (Before Degas) from theMass of Sample tube
set plus sample (After Degas) to obtain the sample’smass. Record this value asMass of
sample (After Degas).
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SAMPLE TUBE INSTALLATION

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it touches the
sample tube bulb.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into the
tube. If using a hanging filler rod, the rod attaches to the Seal Frit.

Do not hold the rod vertically and drop the rod into the tube;
this could break the rod and/or tube.

1. Remove the closure from the sample tube.
2. If a filler rod is used, slide the filler rod slowly into the sample tube.
3. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube

bulb.
4. Place the connector nut, ferrule, andO-ring onto the sample tube stem.

Sample Tube Installation
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6 Perform an Analysis

5. Attach the sample tube to the analysis port, pushing it fully up. Turn the connector nut clock-
wise to hand tighten.
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FILL AND INSTALL THE DEWAR

The equipment images in this topicmay differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

See also:

Dewar Precautions on page 6 - 1

1. Fill the dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than 2 1/4 in.
(5.7 cm) from the top. Filling the dewar higher than this will cause an error in the free space
measurement.

Incorrect fluid levels can lead tomeasurement errors. Check the level of the bath liquid
before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.

Fill and Install the Dewar

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 6 - 11



6 Perform an Analysis

3. For best results, if the dewar has not been used for a while, allow approximately 30minutes
for the temperature of the dewar to stabilize with the bath liquid, then recheck the level of the
bath liquid. Add additional liquid if necessary.

4. Slide the dewar cover to approximately 3/4 in. (19mm) from the sample port nuts to ensure a
proper seal on the top of the dewar.

5. Place the dewar on the elevator.
6. Attach the safety shield to the brackets on the front of the analyzer.
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PERFORM A SAMPLE ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to start
an analysis. Once the analysis window is opened, manual control is disabled until the
analysis has completed. During analysis, pausing and resuming is allowed, however,
steps cannot be skipped.

Unit [n] > Start Analysis

Before beginning an analysis, ensure the tank pressure for the gas regulator is at least
200 psig. Pressures less than 200 psigmay cause the sample to be inadequately sat-
urated, resulting in inaccurate data or termination of analysis.

Evacuation through theUnit > Evacuate Port option can be performed on any idle port while
analyses are in progress.

Standard Analysis Guidelines

l Standard analyses cannot be performed if a high throughput or krypton analysis is in progress.
l One analysis can be started at a time.
l A sample can be added to any idle port and an analysis started without disturbing the analyses
being performed on other ports.

l Samples can be removed from any of the six ports without disturbing the analyses being per-
formed on other ports.

l The sample dosingmethod should beNormal.
l All analysesmust use the same gas.
l If saturation pressure is beingmeasured, all analysesmust use the same Psat gas.

Perform a Sample Analysis
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6 Perform an Analysis

Field or Button Description
Density / Mass /
Sample + Tube /
Empty Tube [text box]

Enter values for the sample’smass and density. These valuesmay be
edited after analysis.

New [button] Creates a new sample file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Sample Analysis

Field or Button Description
Live Graph Settings [but-
ton]

Select Thermal transpiration, x-axis Quantity (relative or absolute pres-
sure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is com-
plete.

Report Port [button] Generates a report on data being collected. The reports are displayed
on the computer monitor only.

Resume [button] Restarts the suspended analysis.

Skip [button] Moves to the next step. Select the ports to skip. In 21CFR11 envir-
onments, steps cannot be skipped.

Sample Analysis Graph
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Field or Button Description
Status window Displays the last point pressure and relative pressure for each port.

Suspend [button] Suspends an analysis in progress.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Sample Analysis Graph (continued)

Perform a Sample Analysis

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 6 - 15



6 Perform an Analysis

PERFORM A HIGH THROUGHPUT ANALYSIS
Unit [n] > Start High Throughput Analysis

In 21CFR11 environments, users are required to login to the Confirm application to start
an analysis. Once the analysis window is opened, manual control is disabled until the
analysis has completed. During analysis, pausing and resuming is allowed, however,
steps cannot be skipped.

Use to perform up to six simultaneous high throughput analyses.

High Throughput Analysis Guidelines

l All portsmust be idle in order to start an analysis.
l All analysesmust use the same analysis gas.
l All analyses that measure Psat must use the same Psat gas (whichmay be different from the
analysis gas).

l The sample file must specifyNormal as the DosingMethod in theAdsorptive Properties.
l From one to six analyses can be started simultaneously.
l Samples cannot be removed from or added to ports until the full set of analyses has completed.

The steps for performing a high throughput analysis are the same as the Krypton analysis. See
Perform a Krypton Analysis on the facing page.
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PERFORM A KRYPTON ANALYSIS
Unit [n] > Start Krypton Analysis

In 21CFR11 environments, users are required to login to the Confirm application to start
an analysis. Once the analysis window is opened, manual control is disabled until the
analysis has completed. During analysis, pausing and resuming is allowed, however,
steps cannot be skipped.

Krypton analyses are available only if the krypton option is installed.

See also:

l Dewar Precautions on page 6 - 1
l Perform a High Throughput Analysis on the
previous page

l Perform a Micropore Analysis on page 6 -
20

l Perform a Sample Analysis on page 6 - 13
l Prepare for Analysis on page 6 - 2

Data collection is done sequentially— one analysis starts and completes before the next
analysis begins.

Use to perform up to five simultaneous krypton analyses.

Krypton Analysis Guidelines

l All portsmust be idle in order to start an analysis.
l All analysesmust use krypton gas.
l From one to five analyses can be started simultaneously. The last port is used to store krypton
for dosing (Port 2, 4, or 6 depending on system configuration).

l An empty sample tubemust be installed in the last port (2, 4, or 6 depending on system con-
figuration).

l The sample file must specifyFrom last sample port as theDosingMethod in theAdsorptive Prop-
erties.

l Samples cannot be removed from or added to ports until the full set of analyses has completed.

Perform a Krypton Analysis

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 6 - 17



6 Perform an Analysis

The dewar below the port used to store and purify kryptonmust be at least 50% full of
the analysis bath liquid and an empty sample tubemust be installed on the port before
starting a krypton analysis.

1. Install an empty sample tube on the port to be used to store krypton (the last port: 2, 4, or 6)
and place a dewar cover over the sample tube stem and the P0 tube stem.

2. Go toUnit > Start Krypton Analysis. For each port to be used, either clickBrowse and
select a sample file or clickNew to create a new sample file.

3. Verify the information populated into the sample identification. This information is pulled from
the sample file. TheDensity value is applicable only if using theCalculatemethod for the free
space determination.

4. Edit theP0 andBath temperature fields, if necessary.
5. ClickReport after analysis to generate reports automatically when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK to return to the pre-
viouswindow.

6. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the Idle state.
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Use theSkip function with caution; the ASAP 2460 performsmultiple steps for a given
task. Skipping certain stepsmay cause corruption of data, instrument damage, or
personal injury.

7. To view an analysis report, click the appropriateReport Port button.
8. When the analysis is complete, theNext button is displayed. ClickClose to exit orNext to per-

form another analysis.

Perform a Krypton Analysis
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6 Perform an Analysis

PERFORM A MICROPORE ANALYSIS
Unit [n] > Start Micropore Analysis

In 21CFR11 environments, users are required to login to the Confirm application to start
an analysis. Once the analysis window is opened, manual control is disabled until the
analysis has completed. During analysis, pausing and resuming is allowed, however,
steps cannot be skipped.

Micropore analyses are available only if theMicropore option is installed.

Micropore Analysis Guidelines

l All portsmust be idle in order to start an analysis.
l All analysesmust use the same analysis gas.
l All analyses that measure Psat must use the same Psat gas (whichmay be different from the
analysis gas).

l The sample dosingmethod should be Normal.
l From one to six analyses can be started simultaneously.
l Samples cannot be removed from or added to ports until the full set of analyses has completed.

The steps for performing aMicroPore analysis are the same as the krypton analysis. SeePerform a
Krypton Analysis on page 6 - 17.
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7 ABOUT REPORTS
Reports > Open Report > [.REP file]
Opens a saved report.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

Reports > Start Report
Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
eitherComplete or Analyzing.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate aHeat of Adsorption report. The isosteric
heat of adsorption is an important parameter for characterizing the surface heterogeneity and for
providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different temperatures
to obtain the heat of adsorption.

Field or Button Description
Add Samples [button] Adds a sample file to the table.

Clear Samples [button] Removes all entries from the table.

Edit Quantities [button] Use to specify the range of surface coverage to include in the report.

Heat of Adsorption Report
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Field or Button Description

Insert Range.Click to specify the starting and ending quantities
adsorbed and number of points to insert.

Load Table. Imports values from another file.

Save Table.Saves the current table as a .QNT file.

Apply.Applies all table changes.
Heat of adsorption plot
[selection]

Generates theHeat of Adsorption data in a graphical format.

Isostere plot [selection] Generates a graph showing quantities of gas adsorbed versus the tem-
perature.

Remove Sample [button] Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Heat of Adsorption Report (continued)

Heat of Adsorption Report
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7 About Reports

SPC REPORT
Reports > SPC Report Options
Use to generate reports with variousSPC (Statistical ProcessControl) options. All selected
variablesmust be computed for each sample file used in an SPC report; therefore, it is more efficient
to select only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and
graph selections inReports > Control Chart. If report options for NLDFT Advanced PSD are
required, clickMore.

7 - 4 MicroActive ASAP 2460Operator Manual
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REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical ProcessControl (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Field or Button Description
Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in the
sample files.

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warningmessage can be safely disregarded.

When this option is selected, thismessage will display:

Regression Report

Regression Report
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7 About Reports

Field or Button Description
Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X- and Y-Axis Variable
[drop-down box]

Use to designate the x- and y-axes variables. The variables in the
drop-down lists are those selected in theReports > SPC Report
Optionswindow. Use these options to plot the regression of up to
three y-axis variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Regression Report (continued)
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CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical ProcessControl (SPC) chart report which plots the changes in a statistic.

Field or Button Description
Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on theReports >
SPC Report Optionswindow. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis label.

Autoscale.Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

Control Chart Report

Control Chart Report
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7 About Reports

Field or Button Description
Center Line.Displays placement options for the center line in the
graph. SelectEntered to specify placement of the line orMean to place
the center line at the calculatedmean value for the selected samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
somemultiple of the standard deviation or at specified positions
(Entered). WhenEntered is selected, enter theHigh limit and Low limit
fields with appropriate values.

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warningmessage can be safely disregarded.

When this option is selected, thismessage will display:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Control Chart Report (continued)
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Field or Button Description
Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X Axis Order by
[group box]

Select the order in which x-axis statistics are placed. Sort by: 

Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which is
the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Control Chart Report (continued)

Control Chart Report
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7 About Reports

MICROACTIVE REPORTS
MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easyway to investigate andmanipulate analysis data using a variety of
reportingmethods.

When a sample file with a status ofComplete, Analyzing or Entered is opened, a linear plot and log
plot of the data collected during analysis are displayed aswell as a summary of the analysis giving
the total pore volume. Numerous reports are accessible from a drop-downmenu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are also
displayed. Plotsmay be edited by selecting the data points or data point range to be included in the
plots andmodifying the parameters. When a report is edited, the results are immediately reflected in
the plots and summary data.

Log in to your customer portal to accessMicroActive Report Tutorials.
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INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

l a linear plot and log plot of the data collected during analysis
l a summary of the analysis giving a single total pore volume and surface area

2. To view the plots in either relative or absolute pressure, select either theRelative Pressure or
Absolute Pressure option.

3. To view the reports selected for generation during the analysis, clickPreview.
4. From the drop-down list at the bottom of the window:

l change the option presentation of the sample information window to either Basic or
Advanced to modify certain file parameters, or

l select another plot from the list and edit the data contained in the plot.

5. When ranges are edited, the changes are reflected immediately in the plots and the summary
data displayed in the window. Some editing options are:

l Drag the blue bars to increase or decrease the range of data included in the plot.
l Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
l Right click to display a popupmenu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular format.

6. ClickSave.

Interactive Reports

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 7 - 11



7 About Reports

EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reductionmethods. This topic discusses the
elements of various reports presented byMicromeritics’ static volumetric physical adsorption
analyzers and suggests ways bywhich themerit of the reported informationmay be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriatemethods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

l Viewing the Validation Report
l Inspecting the IsothermPlot
l Evaluating the Isotherm Tabular Data Set
l Reviewing Reduced Data

VIEW THE VALIDATION REPORT

TheValidation report showswhether the data collected during an analysis are within typical ranges.
Select the types of reports to include by selecting the report in theValidation Report Optionswindow.

When a selected report is generated, if errors occur, a message is displayed across the top portion of
the report and a unique symbol displays on the graph.
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INSPECT THE ISOTHERM PLOT
Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected tomathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so that
details of the low pressure region are revealed. Data in this region are important particularly for
micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical process
beingmonitored. The philosophical question of whether or not these suspected extraneous data
points should be removed from the raw data is not considered here, but it may be appropriate to
exclude an outlier from reduced data. Toomany outliers can cause the integrity of the total data set
to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under reasonable
conditions and using reasonable parameters. For example, confirm that the free space values
reported are typical for the sample holder and bath in use. A problemwith either ambient or analysis
free space valuesmay indicate a free spacemeasurement error and affect all calculations of quantity
adsorbed.

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET
Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the samplemass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be somemultiple of this
level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result. The
solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changesmay indicate that
a gas different from the adsorptive was used in determining P0, that the level of the cryogen fell too
far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular and
graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

1 ) The information in this article is extracted fromAnalytical Methods in Fine Particle Technology,
Webb, P. andOrr, C., (1997).
2 ) Most of the information in this article is extracted fromAnalytical Methods in Fine Particle
Technology,Webb, P. andOrr, C., (1997).

View the Validation Report
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7 About Reports

REVIEW REDUCED DATA
Isotherm datamay be analyzed by any one of several reductionmethods depending on the analyzer
model and pressure range employed. The quality of the results depends on the quality of the
isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which themethod is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.1 )

PHYSICAL PARAMETERS
The value of physical parameters which are used only in data reduction routines should be reviewed
to assure that they agree with experimental conditions. These parameters can be changed and the
experimental data recalculated if an error is discovered or if exploring an alternate value is desired.
Analysis condition values used in the calculation of quantity adsorbed can be changed also. These
are typically themanually entered free space(s), nonideality correction factor, and bath temperature.

The area occupied by a single adsorbedmolecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger2 ) provide a comprehensive review of
such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them by
converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptivesmust be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar volume
of the adsorbate , gas constant , and sample temperature are treated as one constant, the
adsorbate property factor expressed by:

using which, the Kelvin equation3 ) reduces to

1 ) Most of the information in this article is extracted fromAnalytical Methods in Fine Particle
Technology,Webb, P. andOrr, C., (1997).
2 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577 (1967).
3 ) Thomson,W., Phil. Mag. S., 42, 448 (1871).
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Either surface tension, contact angle, or molar volume can be revised individually to give a new value
for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters whichmay be adjusted from those of
the default values. The first is the inside stem (neck) diameter of the sample holder, and the second
is the hard-sphere diameter of the adsorptivemolecule. The sample holder inside diameter is
available from the documentation provided with it or ismeasurable. Information on hard-sphere
diameters of moleculesmay be obtained from handbooks.

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the software
generally are adequate. A search of the technical literature is required if the analysis involves a gas-
solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed (Va) against thickness (t) derived from a thickness
equation, and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data
reductionmethodswere first proposed for specific applications. The user must make a judgment as
to the applicability of themethod to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysismust
be applied only over the linear range and within the range of application. Fitting a regression line to
surface area transformation plots should yield a correlation coefficient of 0.9999 or better and for
t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reductionmodel does not apply to the gas-solid system under examination, then it may be
that either no linear range exists within the pressure range of validity, or that solutions derived from
the regression line of the linear range are intuitively incorrect, that is, they have no relevance to the
physical situation, such as a negative C-value from a BET transform.

1 ) Everett, D.H. and Powl, J.C., J. ChemSoc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).

View the Validation Report
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7 About Reports

BET C-VALUE
BET theory assumes uniform surface coverage with no favored adsorption sites and it also assumes
that the gas ismore strongly attracted to the surface than to other gasmolecules. The typical range
of BET C-values is from about 5 to well over 100. Valuesmuch less than 5 imply that the gas-to-gas
affinity is competing with the gas-to-solid affinity which conflicts with the basic assumptions of BET
theory. C-valuesmuch greater than 100 indicate very strong attraction for the surface or preferential
adsorption.

Provided the isothermwas determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular samplematerial does not conform to the BETmodel. An
inappropriate adsorptionmodel may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about theminimum value expected with fivemore or less equally spaced
points. In the case of indications of poor conformance to the BETmodel, the Langmuir data
reductionmethod should be examined.

DATA ANALYSES BY THE BJH METHOD

In general, thismethod visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive involved
is divided between pore-emptying and film-thinning processes and is accounted for totally. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If
the thickness curve used is too steep, ultimately it will predict a larger increment of adsorptive for a
given pressure increment than is actually observed. The algorithmmust stop since a negative pore
volume is nonphysical. Accumulated error results in the calculation of a too large volume of (possibly
nonexistent) small pores if the thickness curve used underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS

In 21CFR11 environments, members of the Analyst groupmust clickPreview on the
sample file window to access this screen.

Reports can be customized andmanipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

l After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and/or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date/time,
analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information as tabular and graphical reports with the
exception of notes.

Report Features and Shortcuts
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7 About Reports

REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Field or Button Description
Copy header as text Use to copy the report header as text. Text is copied to the clipboard

and then can be pasted into other documents.
Edit Use to edit the report title and/or graphic in the report header.

Report Header Shortcuts
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REPORT TOOLBAR

TheReportwindow has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in theReports list box,
then clickShow.

Field or Button Description
Default Style [button] Specify default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in theReports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in theReports list box.

Print [button] Displays thePrintwindow for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using theHide button.

Show [button] Displays the selected or hidden report in theReports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Report Toolbar

Report Toolbar
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to bemodified.

Field or Button Description
Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. ClickFont to
modify font attributes.

Move column Right click the column to bemoved. SelectMove column on the short-
cut menu and select Left orRight for themove.

Rename column Right click the column to be renamed. SelectRename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. SelectResize column on the short-
cut menu and enter the new columnwidth in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Tabular Report Shortcuts
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GRAPH FEATURES AND SHORTCUTS

Right click in the graph area to display graph report shortcuts.

Field or Button Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy graph Copies the graph to the clipboard. It can then be pasted into other soft-
ware programs.

Edit axis Use to edit the selected axis properties.

Grid lines.Use to change how to displaymajor / minor grid lines.

Scale. [group box]

l Autoscale minimum/maximum. [check box] Tomanually specify
minimum / maximumautoscale, deselect the option and enter the
new amount in the text box.

Graph Shortcuts

Graph Features and Shortcuts
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7 About Reports

Field or Button Description

l Invert scale. [check box]Use to invert the scale.
l Linear/Logarithmic. [selection]Select the option to scale the
graph as linear or logarithmic.

l Scale font. [button]Use tomodify the font for the scale label.
DeselectUse default font to enable font options.

Title. [text box]Use to edit the selected axis label.

Title font. [button]Use tomodify the font for the selected axis label.
Deselect Use default font. Select new font attributes for report data.
EnableUse default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Color. [button]Click to change the curve color.

Curve. [group box]Use to change the interpolation, point style, and
pen style for the selected curve. These options are disabled ifUse
default fill style is selected in theHistogram group box.

Histogram. [group box]Enabled only ifHistogram is selected in the
Style drop-down list. Use to specify the type of fill, fill color, and label
position for the selected curve.

Label. [drop-down box]Select where the graph point labels will
display (left, right, center, etc.) on the SPC report.

Graph Shortcuts (continued)
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Field or Button Description

Style. [drop-down box]Use to select another style for the collected
data curve.

Title. [text box]Use to change the title of the selected curve.

Use default thickness. [check box]Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text box.

Edit legend Use to change the legend location and font.

Edit title Select to change the report title.

Enable overlays If overlays have been selected, this option displays (or hides) the over-
lays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on theReport Options tab.

Reset axis limits to ini-
tial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Graph Shortcuts (continued)

Graph Features and Shortcuts

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 7 - 23



7 About Reports

Field or Button Description
Select overlays... Displays the option to select files to overlay onto the active graph. To

view the overlays, clickEnable Overlays on the shortcut menu.
Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Graph Shortcuts (continued)

Axis Cross-Hair

Left click on the graph to view the cross-hair coordinates.
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Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. Thismenu option is not available if usingRestricted
option presentation.

Field or Button Description
Grid Line Styles
[selection]

Select if themajor and/or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Graph Grid Lines

Zoom Feature

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A boxwill display in the area to be enlarged. To return to normal view,
right click in the graph and selectAutoscale all axes.

Graph Features and Shortcuts
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7 About Reports

GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

Use the graph overlay functions to comparemultiple graph options. Graphical lines are differentiated
by the use of varying colored symbols outlined on a legend. Overlaysmay be generated in two ways:

l Multiple Graph Overlays.Overlay two different types of graphs from one sample.
l Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when usingAdvanced option presentation. Go toOptions
> Option Presentation > Advanced.
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GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physical adsorption applications can produce graphical results for a
samplematerial's pore size distribution:

See also:

l BJH Adsorption/Desorption Report Options on page 8 - 6
l DFT Pore Size Report Options on page 8 - 12
l Dollimore-Heal Adsorption/Desorption Report Options on page 8 - 15
l Horvath-Kawazoe Report Options on page 8 - 29

Twomethods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

l Import ASCII text data.Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

l Copy/paste.Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlaysmenu selections are:

l Copy data.Used to copy data sets.
l Paste data.Used to paste data sets.
l Edit Imported Data.Used to edit data sets.
l Display Imported Data.Used to hide or show the imported data.

IMPORT ASCII TEXT DATA

ASCII text file format rules

l The header must consist of one line to include title, two unit specifications, and distribution type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

Generate Pore Size Distribution GraphOverlays
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7 About Reports

l The datamust be in two columns and should be separated by a comma or white-space.
l The data linesmust be ordered so that pore dimensions aremonotonically increasing or decreas-
ing.

silica alumina bjh (A, cm3/g, cumulative)

456.657
444.847
429.168
425.419
419.629
360.634
340.859
326.601

0.0133559
0.0546427
0.0869924
0.119721
0.132681
0.156611
0.197672
0.233092

Sample ASCII Text File

Window appearance will vary depending on the selected report. This function can be performed on
samples files with aCompleted status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open. Select a sample file to overlay graphs on to.

ClickOpen (or double-click the file name).
3. Right click in the graph area and selectEdit imported data.
4. In theSelect Imported Overlayswindow, if the ASCII text file does not display, click Import to

locate the file. Select the ASCII text file in theSelect Imported Overlayswindow, then click
OK. If an error message will display instead, verify that the .TXT file format is in the correct
format.

5. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay
Data in Reports on the facing page.

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have aComplete status. The

report will open to the interactive reports window.
2. In the source sample file, right click on the graph and selectShow Curve. Deselect any dif-

ferential curve data to hide them in the graph.
3. Right click in the graph area again and selectCopyData.
4. Change to the target sample file, right click the graph, and selectPaste data. The graph now

displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves. To
show or hide individual curves, right click the graph and select (or deselect)Display imported
data.
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5. Ensure that all parameter fields are set appropriately, then clickPaste.
6. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay

Data in Reports below.

Print Pore Size Distribution Overlay Data in Reports

1. Open the sample file containing the overlay data and selectAdvanced from the drop-down list
at the bottom of the window.

2. Click theReport Options tab.
3. In theSelected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then clickEdit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. ClickPreview on theReport Options tab. ClickPrint in the reports toolbar section to display

print options.

Generate Pore Size Distribution GraphOverlays
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7 About Reports

OVERLAY MULTIPLE SAMPLE FILES

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

To overlay the same type of graph onmultiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, selectAdvanced from the

drop-down list at the bottom of the window to display the tabbed window view.
3. Click theReport Options tab.
4. In theSelected Reports list box, highlight a report then clickEdit. Use the following table to

complete the process for the selected report.
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If overlaying this type of
report...

Then...

l Isotherm

a. On the IsothermReport Optionswindow, select one or
more plots in theSelected Reports group box, then click
Options to the right of the selected plot.

b. On thePlot Optionswindow, selectPlot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enableAutoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the IsothermReport Optionswindow, in thePlot
Options group box, selectPlot overlays. ClickOK.

d. Continue to Step 5.

l Alpha-S Method
l BET Surface Area
l f-Ratio Method
l Freundlich
l Langmuir Surface Area
l t-plot
l Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

l BJH
l Dollimore-Heal
l MP-Method

a. Select the report variable from theSelected Reports group
box, then clickEdit.

b. Click the down arrow on theOverlay field, then select the
Samples option. Verify other fields. ClickOK.

c. ClickOK again.

5. On theReport Options tab, clickOverlays.
6. On thePlot Overlay Sample Selectionwindow, move up to 25 files from theAvailable Files

box to theSelected Files box:

7. ClickOK.
8. To view the report, clickPreview.

OverlayMultiple Sample Files
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7 About Reports

Field Description
Status [drop-down box] Select the status of files to be combined.

Look in [button] Click theBrowse icon to change the file folder location.

Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then clickAdd. The selected files aremoved to theSelected
Files list box.

Selected Files
[selection]

Lists the files selected to be combined. ClickOK to combine the files.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Plot Overlay Sample Selection
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IMPORT ASCII PORE DISTRIBUTION DATA

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 7.
2. Open a report with aComplete status.
3. Select a pore-size distribution report from the drop-down list at the bottom of the window.
4. Right click on the graph and selectEdit imported data on the shortcut menu.

If the ASCII text file does not display on theSelected Imported Overlayswindow, click Import.
Locate and select the file, then clickOpen. Header information from the ASCII text file will
appear in theSelect Imported Overlayswindow. Select the entry, then clickOK. If an error
message appears, verify that the .TXT file format is correct.

5. To hide or show imported data, right click in the graph area and use theDisplay imported data
option on the shortcut menu.

COPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 7.
2. Copy the ASCII text data to the clipboard.
3. Open a report with aComplete status.
4. Select a pore-size distribution report from the drop-down list at the bottom of the window.
5. Right click on the graph and selectPaste data on the shortcut menu.
6. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.

COPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with aComplete status.
2. Right click on the graph and selectCopyData on the shortcut menu.
3. Open the target pore distribution data report.
4. Right click on the graph and selectPaste Data on the shortcut menu.
5. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.

Import ASCII Pore Distribution Data
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7 About Reports

REPORT EXAMPLES

BET SURFACE AREA PLOT

7 - 34 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



BET SURFACE AREA

BET Surface Area
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7 About Reports

BJH ADSORPTION - CUMULATIVE PORE VOLUME REPORT
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BJH DESORPTION - CUMULATIVE PORE VOLUME REPORT

BJH Desorption - Cumulative Pore VolumeReport
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7 About Reports

ISOTHERM LINEAR PLOT

7 - 38 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



T-PLOT REPORT

t-Plot Report
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8 SELECTED REPORTS

In 21CFR11 environments, this feature is applicable tomembers of the Developer
group only.

To edit reports, open theSample file then select theReport Options tab. Highlight the
report name in theSelected Reports list box and clickEdit.

Log in to your customer portal to accessMicroActive Report Tutorials.

ADVANCED REPORT OPTIONS

See:

Advanced Reports - Python Module on page A - 1

8 Selected Reports
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246-42800-01 (Rev F)— 2018 8 - 1

http://www.micromeritics.com/Customer-Login.aspx


8 Selected Reports

ALPHA-S METHOD REPORT OPTIONS

TheAlpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the
quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in theReference file directory. Use the table buttons to enter relative
pressure and the alpha-s values.

Field or Button Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be importedmust be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columnsmust be separated by a space or a tab.

Alpha-S Method Reports
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used to
calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimumandmaximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.
l Autoscale x-axis. The x-axis field shows the relative pressure.
l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the plot.
Tabular Report.Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Alpha-S Method Reports (continued)

Alpha-S Method Report Options
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8 Selected Reports

BET SURFACE AREA REPORT OPTIONS

The BET calculation obtains the sample surface area value by determining themonolayer volume of
adsorbed gas from the isotherm data. BET uses amultilayer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of Analyzing

orComplete. Use to enter a range of pressure points to be included in
the report or to modify table values for pressure points.

Calculation pressure range.Enter theminimumandmaximum
pressures to be used in the pressure table if not using theUse
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Reports
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Field or Button Description
Include All. Select to include all pressure points in the table.

Insert Predefined.Click to insert a predefined (default) set of points
into the report.Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation.Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot.Uses BET monolayer volume and constant to
produce an isotherm.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the BET isotherm
plot.

BET Transform plot.Use to generate a traditional BET surface area
plot used to determinemonolayer volume and BET C constant.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

l Autoscale y-axis. The y-axis field showsBET transformation.
l Overlay samples.Use to overlay sample files on the
BET transform plot.

Tabular report.Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

BET Reports (continued)

BET Surface Area Report Options
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8 Selected Reports

BJH ADSORPTION/DESORPTION REPORT OPTIONS

The BJH calculation determines themesopore volume/area distribution, which accounts for both the
change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for bothBJH Adsorption Report
Options andBJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distributionmay be generated if a thickness curve selection is not a
goodmatch for the sample being analyzed.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

BJH Adsorption/Desorption Reports
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Field or Button Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected type
will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard.Uses original BJH models.
Cumulative Reports
[group box]

Larger.Use to report the total volume found in pores larger than the
current pore size.

Smaller.Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter theminimumandmaximumdiameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
theBJH Desorption Report Optionswindow.

During adsorption calculations, the analysis program assumes that all
pores are closed at one end. Occasionally, a percentage of poresmay
be open at both ends causing disagreement in the adsorption and
desorption data or in the values for total volume and total BJH pore
volume. Enter the fraction of pores open at both ends to compensate
for this error.

BJH Adsorption/Desorption Reports (continued)

BJH Adsorption/Desorption Report Options
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8 Selected Reports

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then clickEdit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

BJH Adsorption/Desorption Reports (continued)
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Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

BJH Adsorption/Desorption Reports (continued)

BJH Adsorption/Desorption Report Options
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BJH PLOT OPTIONS

The fields for all plot options are identical for specifying plottingmethods and customizing plots.
Highlight any plot option in theSelected Reports list box in theBJH Report Optionswindow, then
clickEdit.

Field or Button Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically.Autoscalemeans that the x- and
y- rangeswill be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable.Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

BJH Plot Reports
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BJH TABULAR REPORT OPTIONS

HighlightBJH Tabular Report in theSelected Reports list box on theBJH Adsorption Report
Optionswindow, then clickEdit to specify themethod of data reduction.

Field or Button Description
Collected points
[selection]

Use to include all relative pressure points collected. Refer to the
Columns button below.

Columns [button] Select the data types to include in the report.Column [n] indicates the
column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. ClickTable to
modify the fixed pore size table. Refer to Table andColumns buttons
elsewhere in this table.

Table [button] The fixed pore size tablemust contain aminimumof two points. The
pointsmust be strictly decreasing. Enabled only when Fixed pore size
table is selected.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

BJH Tabular Reports

BJH Adsorption/Desorption Report Options
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DFT PORE SIZE REPORT OPTIONS

TheDFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro andmesopore ranges.

Field or Button Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists themodels that meet the specified criteria andmatch the
adsorbate and temperature of the sample data. If nomodels appear,
nomodelsmeet the selected criteria. Onemodel must be selected.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

DFT Pore Size Reports
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Field or Button Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relative weight for the
smoothing during deconvolution. Larger values producemore smooth-
ing.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and clickEdit. The LogGoodness of Fit andGoodness of
Fit graphs cannot be edited.

Autoscale Options.Use to autoscale the x-axis and/or y-axes.

Axis Range. From/To fields are enabled whenAutoscale options are
not selected. Enter the starting and ending values for the x- and/or y-
axes.

l x-axis.Shows the pore size.
l y-axis.Shows the area.

Overlay.Select an overlay for the report.

Plot Type.Select themethod for data display.

DFT Pore Size Reports (continued)

DFT Pore Size Report Options

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 8 - 13
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Field or Button Description
Type [drop-down box] Classical. Model based on the Kelvin equation and thickness for

determining the pore size distribution. SeeDFT Models on page B -
1.

DFT.Model based on the density functional theory.
Version 2 decon-
volution [check box]

If enabled, adds improved performance for nonzero values of the DFT
regularization. The DFT results will be slightly better than when the
checkbox is not selected and when using a regularization parameter.
When the checkbox is not selected, the legacy behavior of the DFT
calculation used by earlier versions of the application is produced.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

DFT Pore Size Reports (continued)

DFT SURFACE ENERGY REPORT OPTIONS

See also:

DFT Pore Size Report Options on page 8 - 12

TheDFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface EnergyReport Options fields and buttons are identical to theDFT Pore Size Report
Options.
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DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT OPTIONS

See also:

BJH Adsorption/Desorption Report Options on page 8 - 6 for additional
information on field and buttons for this report.

TheDollimore-Heal Adsorption Report Option and theDollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

Dollimore-Heal Adsorption/Desorption Reports

Dollimore-Heal Adsorption/Desorption Report Options
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8 Selected Reports

Field or Button Description
Cumulative Reports
[group box]

Larger.Use to report the total volume found in pores larger than the
current pore size.

Smaller.Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter theminimumandmaximumdiameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then clickEdit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

Dollimore-Heal Adsorption/Desorption Reports (continued)
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Field or Button Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Dollimore-Heal Adsorption/Desorption Reports (continued)

Dollimore-Heal Adsorption/Desorption Report Options
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DOLLIMORE-HEAL PLOT OPTIONS

See also:

BJH Plot Options on page 8 - 10

The fields for all plot options are identical for specifying plottingmethods and customizing plots.
Highlight any plot option in theSelected Reports list box in theDollimore-Heal Report Options
window, then clickEdit. The fields and buttons for these reports are identical to theBJH Plot Report
Options.
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DOLLIMORE-HEAL TABULAR REPORT OPTIONS

See also:

BJH Tabular Report Options on page 8 - 11

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.

Dollimore-Heal Adsorption/Desorption Report Options
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DUBININ REPORT OPTIONS

TheDubininmethod provides pore volume distributions for microporousmaterials bymaking use of
an expression for the adsorption potential.

Field or Button Description
Adsorptive [button] Displays theAdsorptive Optionswindow. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinationsmay be specified.

Fitted Relative Pres-
sure Range
[group box]

Enter theminimumandmaximum limits for Radushkevich or Astakhov
relative pressures included in the line fit.

Dubinin Reports
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Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize expo-
nent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then clickEdit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Dubinin Reports (continued)

Dubinin Report Options
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DUBININ PORE VOLUME REPORT OPTIONS

In theDubinin Report Optionswindow, highlight dV/dw Pore Volume in theSelected Reports list
box, then clickEdit.

This option plots differential pore volume as a function of pore width.

Field or Button Description
Autoscale x-axis / Auto-
scale y-axis [check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending valuesmanually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Dubinin Pore Volume Reports
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DUBININ TABULAR REPORT OPTIONS

In theDubinin Report Optionswindow, highlightDubinin Tabular Report in theSelected Reports list
box, then clickEdit.Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Optionswindow. If not, then the value for [n] is the entered exponent value.

Dubinin Report Options

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 8 - 23



8 Selected Reports

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

Highlight Transformed Isotherm in theSelected Reports list box in theDubinin Report Options
window, then clickEdit.

The transformedDubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lineswhen transformed in this way.

Field or Button Description
Autoscale x-axis / Auto-
scale y-axis [check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending valuesmanually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis.Shows the log of relative pressure.
Overlay Samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Dubinin Transformed Isotherm Plot Reports
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F-RATIO METHOD REPORT OPTIONS

The f-Ratio report uses themeasured isotherm and normalizes it using a reference isotherm.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

f-Ratio Reports

f-Ratio Method Report Options
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8 Selected Reports

Field or Button Description
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isothermmeasured from a non-porous
sample of the samematerial as the current sample.

Selected Reports
[group box]

Tabular Report.Use to have a tabular report of data generated.

f-Plot.Use to generate a normalized isotherm.

l Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

f-Ratio Reports (continued)
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FREUNDLICH REPORT OPTIONS

The Freundlich Isotherm is an empirical isotherm used tomodel low-pressure adsorption data. It can
also be applied tomodel somemicropore isotherms. In theSelected Reports list box, highlight
Freundlich, then clickEdit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Freundlich Reports

Freundlich Report Options
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8 Selected Reports

Field or Button Description
Select Reports
[group box]

Freundlich Isotherm plot.Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

l Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

l Overlay samples.Use to overlay sample files on the Freundlich iso-
therm plot.

Freundlich Transform plot.Plots the log(P) vs log(Q) and the best
fit.

l Autoscale x-axis. The x-axis field shows the absolute pressure.
l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the Freundlich
transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter themonolayer capacity of the sample.

Tabular report [selec-
tion]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Freundlich Reports (continued)
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HORVATH-KAWAZOE REPORT OPTIONS

TheHorvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Field or Button Description
Apply Cheng-Yang cor-
rection [selection]

Use to apply the Cheng-Yang correction to the pore size analysis. This
correction substitutes the Langmuir equation of state for Henry’s Law
in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in thePore
Geometry group box.

Computed.Use to calculate using the parameters on theHorvath-
Kawazoe Physical Propertieswindow (clickProperties to display the
Physical Propertieswindow). The interaction parameter is
recalculated each time a parameter in thePhysical Propertieswindow
is edited.

Entered.Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the samplematerial. WhenSphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Reports

Horvath-Kawazoe Report Options
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8 Selected Reports

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties of

the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in theDiameter andDiameter at zero energy
text fieldsmay be edited.

l Density.Enter the density per unit area of the sample. *
l Description.Select the name of the sample used in the analysis.
l Diameter.Enter the diameter of the sample atom.
l Diameter at zero energy.Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 × diameter.

l Magnetic susceptibility.Enter themagnetic susceptibility of the
sample. *

l Polarizability.Enter the polarizability of the sample. *
Adsorptive.Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in theDiameter andDiameter at zero energy
text fieldsmay be edited.

l Density.Enter the density per unit area of the adsorptive. *
l Diameter.Enter the diameter of the gas phase atom.

Horvath-Kawazoe Reports (continued)
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Field or Button Description

l Diameter at zero energy.Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 × diameter.

l Magnetic susceptibility.Enter themagnetic susceptibility of the
adsorptive. *

l Mnemonic.  Select themnemonic of the adsorptive gas in use.
l Polarizability.Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then click
Edit to modify report parameters.

Smooth Differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations in
the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Horvath-Kawazoe Reports (continued)

Horvath-Kawazoe Report Options
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8 Selected Reports

HORVATH-KAWAZOE PLOT OPTIONS

See also:

BJH Plot Options on page 8 - 10 for additional information on fields and buttons for
this report.

Highlight a plot option in theSelected Reports list box in theHorvath-Kawazoe Report Options
window, then clickEdit to customize the plottingmethod.

HORVATH-KAWAZOE TABULAR REPORT OPTIONS

HighlightH-K Tabular Report in theSelected Reports list box in theHorvath-Kawazoe Report
Optionswindow, then clickEdit. Select the data types to include in the report.Column [n] indicates
the column order and data contents for the report.
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ISOTHERM REPORT OPTIONS

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Field or Button Description
Options [button] Click to display related linear plot options. All plot windows contain

identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points.Select to plot points on the graph.
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

l per gram (cm3/g) STP
l per BET Surface Area (cm3/m2) STP or mmol/g
l per other Surface Area (cm3/m2) STP or mmol/m2

Isotherm Reports

IsothermReport Options
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8 Selected Reports

Field or Button Description
Selected Reports
[group box]

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter themass percentage when plotting pressure
composition.

Tabular Report
[group box]

Select to include tabular data in the report.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Isotherm Reports (continued)
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LANGMUIR REPORT OPTIONS

The Langmuir calculation determines the surface area of a sample by relating the surface area to the
volume of gas adsorbed as amonolayer. Langmuir uses a single layer model.

Field or Button Description
Pressures [button] This option is available when the sample file has a status of

Analyzing orComplete. Use to enter a range of pressure
points to be included in the report or to modify table values for
pressure points.

Calculation pressure range.Enter theminimumand

Langmuir Reports

Langmuir Report Options
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8 Selected Reports

Field or Button Description
maximumpressures to be used in the pressure table. To
exclude a point from the calculations used to generate the
report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation.Use to indicate if the system should use
the table or interpolated data. This option is available for BET
and Langmuir reports only.

Select Pressure Range for
Langmuir fit [group box]

Enter values to indicate the fitted pressure range.

Selected Reports [group box] Langmuir Isotherm Plot.Uses the Langmuir monolayer
volume and constant to produce an isotherm.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis
field shows the absolute pressure for Langmuir.

l Autoscale y-axis. The y-axis field shows the quantity of
gas adsorbed.

l Overlay samples.Use to overlay sample files on the Lang-
muir isotherm plot.

Langmuir Transform Plot.Use to generate a traditional
Langmuir surface area plot used to determinemonolayer
volume constant.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis
field shows the absolute pressure for Langmuir.

l Autoscale y-axis. The y-axis field shows Langmuir trans-
formation.

l Overlay samples.Use to overlay sample files on the Lang-
muir transform plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Langmuir Reports (continued)
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MP-METHOD REPORT OPTIONS

TheMP-Method Report Options provides pore volume distributions for microporousmaterials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go toOptions
> Units to specify the unit.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Reports

MP-Method Report Options
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8 Selected Reports

Field or Button Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then clickEdit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

MP-Method Reports (continued)
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MP-METHOD PLOT REPORT OPTIONS

In theMP-Method Report Optionswindow, highlight a plot option in theSelected Reports list box,
then clickEdit to customize the plottingmethod.

Field or Button Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale.Use to have the y-axis autoscaled or enter beginning and
ending values.

Overlay.Select an option to overlay on the current report.

Variable.Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

MP Method Plot Reports

MP-Method Report Options
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8 Selected Reports

MP-METHOD TABULAR REPORT OPTIONS

In theMP-Method Report Optionswindow, highlightMP Tabular Report in theSelected Reports list
box, then clickEdit.Column [n] indicates the column order and data contents for the report.

TheMPMethod reports hydraulic radius only. If Pore size in diameter is selected on the
Unit Selection window, pore size in radius will be reported.

NLDFT ADVANCED PSD REPORT
TheNLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of amaterial using two separate analyses and two non-local DFTmodels.

TheNLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option andmore. The NLDFT report compares two sample files. Themodels that can be
selected are restricted to only thosemodels which have the same analysis temperature and analysis
gas as the sample file that is open. For instance, if the sample file was analyzed with N2 at
77 degrees Kelvin, then only the N2DFTmodels at 77 degrees Kelvin will be available in theModel
drop-down list.
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Themodel curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data points,
choice of model, choice of regularization parameter).

A second sample file and secondmodel is used to compute amore accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used the
same samplematerial as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The advanced
DFT calculation takes the data from both sample files and combines all this data into amore accurate
calculation of the pore size distribution. More accuratemeans getting the pore distribution at smaller
pore sizes (a few Angstroms) aswell as larger pore sizes (one thousand Angstroms).

Tomake a successful advanced calculation, a second sample file must be selected
using theSelect button. A secondmodel must also be selected. Use the options next to
the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isothermwill appear in the isotherm plot
(lower right) as well as a second curve-fit. As the selection of points is adjusted, the DFT
editor will recalculate the PSD results and also recalculate the twomodel curve fits.

NLDFT Advanced PSD Report
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8 Selected Reports

Field or Button Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists themodels that meet the specified criteria andmatch the
adsorbate and temperature of the sample data. If nomodels appear,
nomodelsmeet the selected criteria. Onemodel must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relativemass for the
smoothing during deconvolution. Larger values producemore
smoothing.

Select Reports
[group box]

Use to select the second sample file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

NLDFT Advanced PSD Reports

To run the NLDFT report:

1. Go to File > Open. Select a sample file with aComplete status, then clickOpen.
2. In the drop-down list at the bottom of the window, selectNLDFT Advanced PSD. Graphs for

the first sample file display and the sample description shows as the first group box title in the
upper right corner of the window.
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a. Select theGeometry andModel from the drop-down lists for the first sample file.
b. To select isotherm data points for calculation for the first sample file, ensure the option to

the left of the first sample file description is selected. Slide the two blue bars on the iso-
therm graph to select data points. Without a second sample selected, the report will per-
form a singlemodel DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, clickSelect to locate and open the second
sample file with aComplete status. Graphs for the second sample file display and the sample
description will display as the second group box title in the upper right corner of the window.
a. Select theGeometry andModel from the drop-down lists for the second sample file.
b. To select isotherm data points for calculation for the second sample file, ensure the option

to the left of the second sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Data are automatically calculated for both sample
files.

c. ClickEdit to make any necessarymodifications to the second sample file.

NLDFT Advanced PSD Report
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8 Selected Reports

OPTIONS REPORT
Lists the conditions used to perform the analysis— such as:

l Adsorptive properties
l Analysis conditions
l Analysismethod
l Degas conditions
l Free space
l Saturation pressure (P0) and temperature

Options reports cannot be edited.
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SAMPLE AUDIT TRAIL REPORT

For 21CFR11 environments only.

This report lists all changes and comments that have been applied to sample files with aCompleted
status.

SAMPLE LOG REPORT

Not applicable to 21CFR11 environments. SeeSample Audit Trail Report above.

This report provides information on:

l Manual control operations performed during analysis.
l Information entered usingAdd Log Entry on the sample file editor.
l Warnings and/or errors which occurred during analysis.

Sample Audit Trail Report
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8 Selected Reports

SUMMARY REPORT OPTIONS

TheSummaryReport for physical adsorption analyses provides a condensed summary of selected
data results.

In thePore Volume group box, if Adsorption total orDesorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Field or Button Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until theSummaryReport is

selected,S A Single-point BETwill be displayed by default. When
selected, clickPass/Fail, then select pass/fail criteria options.

Pass/Fail [n].Click to display thePass/Fail Optionswindow for
selection of pass/fail criteria.

S A: Single-point BET.Use to enablePass/Fail [n] in the Item [n]
group box.

Summary Report
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Field or Button Description
Upper/Lower.Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right ofUpper / Lower, enter operator instructions to be
displayed if a failure is encountered.

Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Summary Report (continued)

TheSummaryReport for dynamic analyses provides a condensed summary of the peaks and
selected analysis parameters.

SummaryReport Options
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T-PLOT REPORT OPTIONS

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves to
be a valuable way of characterizing complexmixedmaterials.

Field or Button Description
Fitted thickness range
[text box]

Enter theminimumandmaximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Reports

8 - 48 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



Field or Button Description
Selected Reports
[group box]

Tabular Report.Use to have a tabular report of data generated.

t-Plot.Use to have a graphical representation of data generated.
l Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area andmicropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
themost commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then clickEdit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA.Select the thickness curve option,
then clickEdit. Modify the equation for the selected curve as needed.

Reference.SelectReference, then clickEdit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
theReference directory.

t-Plot Reports (continued)

t-Plot Report Options
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Field or Button Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
importedmust have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columnsmust be separated by
a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples.Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

t-Plot Reports (continued)
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TEMKIN REPORT OPTIONS

The Temkin isotherm is used tomodel adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter theminimumandmaximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, selectExclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Temkin Reports

Temkin Report Options
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Field or Button Description
Selected Reports
[group box]

Tabular Report. Generates a tabular report of the included samples.
A tabular report contains the numeric values contributed by each
sample.

Temkin Isotherm plot. Overlays the Temkin isothermwith the
analysis data.

l Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

l Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

l Overlay samples.Use to overlay sample files on the isotherm plot.

Temkin Transform plot. Plots a linear form of the Temkin transform
plot.

l Autoscale x-axis. The x-axis field shows the logarithm of pressure
(ln).

l Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

l Overlay samples.Use to overlay sample files on the transform
plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface cov-
erage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter themonolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Temkin Reports (continued)
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VALIDATION REPORT OPTIONS

This report allows data to be examined by the analysis program to determine if the results are within
typical ranges. If the data for any reports selected for validation are determined to be out of range, a
warning will display and suggestions are given for corrective action. This information is detailed in the
report and plotted on the graph as a unique plot symbol.

Validation Report Options
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9 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start diagnostic tests, and open saved diagnostic reports. Each
test generates a file to the default directory name and path of ...\...\Service\userdiag unless another
directory namewas specified. These reports can be sent to aMicromeritics Service Representative
for examination.

SHOW ALL READINGS
Unit [n] > Diagnostics > Show All Readings
TheShow All Readingswindow displays the calibrated and nominal readings of all sensors in the
system.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Provides amethod to start a diagnostic test immediately. Upon completion of the diagnostic test, the
file is saved as a .REP file which can be retrieved by going toReports > Open Report and
selecting the report file.

9 Diagnostics
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9 Diagnostics

Field or Button Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.) Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Start Diagnostic Test

9 - 2 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



10 CALIBRATION
Unit [n] > Calibration

Service Test Mode is required for this test. SeeService Test Mode on page 11 - 31.

A calibration file was created specifically for the analyzer and included with the accessories. It is not
necessary to recalibrate the system unless it seems out of calibration.

Disabled calibrationmenu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go toUnit [n] > Unit Configuration.

A referencematerial analysis can be run (if necessary) to ensure the highest quality data. Each kit
contains referencematerial and an instruction booklet. Follow the instructions in the reference
material booklet to perform the analysis and review the results.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

10 Calibration
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10 Calibration

PRESSURE OFFSET

Unit [n] > Calibration > Pressure Offset
This procedure evacuates the system and zeroes the pressure transducers. This calibration should
only be performed by qualified service personnel. In order to perform this procedure, sample tubes
must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then clickStart. ClickOK when the pro-

cess is complete.
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MATCH TRANSDUCERS
Unit [n] > Calibration > Match Transducers
Use to evacuate the system and zero the pressure transducers, then adjust the scale tomatch them
to themanifold transducer near full scale pressure.

A blank sample tube or small plugmust be installed on each selected port prior to start-
ing this process.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then clickStart. The window closeswhen

the operation is complete. ClickOK when the process is complete.

Match Transducers
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10 Calibration

SERVO VALVE
Unit [n] > Calibration > Servo Valve
Use to calibrate the servo valve to themanifold pressure transducer. The servo valve should always
be recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this procedure.
Go toUnit [n] > Unit Configuration and view the calibration information. Contact your
Micromeritics Service Representative if calibration dates are not listed.

ClickStart. The window closeswhen the calibration is complete. ClickCancel to stop the calibration
process.
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LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved usingUnit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration file,
a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each
time a new one is created.

Changing the calibrationmay affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension

Load Calibration from File
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11 TROUBLESHOOTING AND MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time.When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Log in to your customer portal to access error messages. Parts and accessories can be found online
at www.Micromeritics.com.

Most operational problems are caused by the following:

l Leaks (commonly around the sample tubeO-ring at the analysis port)
l Sample weighing errors
l Use of toomuch analysis bath fluid in the dewar at the start of an analysis
l Entry of incorrect system volume for analysis

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Analysis valves cannot be operated.

Cause: Cable from computer to the analyzer is loose.

Action: Ensure the cable is seated properly.

Vacuum pump gurgles continuously.

Cause A: Sample tube connector nut is loose.

Action A: Turn the sample tube connector nut clockwise to tighten.

Cause B: Sample tube fitting is loose.

Action B: Tighten the fitting securely with a wrench.

Cause C: Sample tubeO-ring is worn or cracked.

Action C: Replace the sample tubeO-ring. SeeReplace the Sample Tube O-ring on

11 Troubleshooting andMaintenance
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11 Troubleshooting andMaintenance

page 11 - 25.
Cause D: Sample tube is cracked.

Action D: Replace with a new sample tube.

Cause E: No sample tube is loaded on a selected port.

Action E: Enure the port valve is closed. Install a plug or empty sample tube on the port.

Cause F: A gas inlet valve is open while the vacuum valve is open.

Action F: Enablemanual control, then use the analyzer schematic to close the gas inlet valve.
SeeEnable Manual Control on page 11 - 19.

Vacuum gauge shows reading above 20 mmHg, even after extended pumping through
unrestricted valve with analysis or degas ports closed.

Cause A: Oil-based Pump Only.Vacuum pump oil is low, causing ineffective evacuation.

Action A: Add or change vacuum pump oil. Add oil to proper level according to oil level window.

Cause B: Oil-based Pump Only.No power to the vacuum pump.

Action B: Check the pump power plug, power switch, and line circuit breaker.

Cause C: Oil-based Pump Only. Filter in port being used is dirty.
Action C: Replace filter in port. SeeReplace the Analysis Port Filter on page 11 - 23.
Cause D: Oil-based Pump Only. The alumina in the oil vapor trap is holdingmoisture.
Action D: Replace or dry the alumina. Log in to your customer portal to access the Vacuum

PumpGuide for information on replacing and drying alumina.

Cause E: Oil Free Pump Only. Filter in port being used is dirty.
Action E: Replace filter in port. SeeReplace Port Filters on page 11 - 23.
Cause F: Oil Free Pump Only.High vacuum pumpmay have timed out.

Action F: Power OFF the high vacuum pump, then power if backON.

CauseG: Oil Free Pump Only.No power to the vacuum pump.

Action G: Check the pump power plug, power switch, and line circuit breaker.

Cause H: Oil Free Pump Only. The diaphragm(s) in the pump is worn or damaged.
Action H: Contact your Micromeritics Service Representative.
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GUIDELINES FOR CONNECTING GASES

l Place gas cylinders within 6 feet (2m) of the gas inlets of the analyzer. Using gas line extenders
on gas cylinders located in remote areasmay degrade gas quality and reduce pressure. Gas lines
are typically five to six feet long. Place the cylinders close enough to allow for proper connection at
the analyzer inlet.

l Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
l Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible linesmay appear to be appropriate, such as those
with a herringbone covering, but the linemay be coated internally with a polymer.

l Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated
for an extended period of time to remove ambient gases.When possible, avoid placing gas cyl-
inders in remote locations. It is always best to have gas cylinders located near the analyzer.

l Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling
gas lines. This will help avoid confusion whenmaintenance is required.

l Label the gas line at the analyzer inlet for proper identification andmaintenance.
l Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

l Ensure the gas cylinder is closed before connecting to the analyzer.

Guidelines for Connecting Gases
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11 Troubleshooting andMaintenance

CLEAN AND VERIFY THE GAS LINE

Only evacuate the gas lines back to the gas cylinder if the gas lines are within 12 feet of
the analyzer. Do not perform this procedure if the gas lines connected to the analyzer
are longer than the 6 ft lines shipped with the analyzer.

There are twomethods for cleaning and verifying gas lines:

l use the diagnostic test. SeeSoftware Diagnostic Test to Clean and Verify Gas Lines
below, or

l perform the test manually. Thismethod is less time consuming but should only be used by exper-
ienced service personnel. SeeManual Method to Clean and Verify Gas Lines on page 11 -
8.

SOFTWARE DIAGNOSTIC TEST TO CLEAN AND VERIFY GAS LINES
Unit [n] > Diagnostics > Start Diagnostic Test
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shutoff valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low-pressure gauge are as follows:
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1. SelectClean and Verify Analysis Gas Line [n] Test Rev [n] in the Test field. The length of time
a test will run is also indicated on the window. TheSequence field indicates the file created as
a result of this test.

2. In theOperator field, enter either the name or initials of the operator performing this test.
3. Resize the window (if necessary) to display theReport after test option, then selectPreview

as the destination. ClickStart.
4. From theView drop-down list, select eitherOperation, Instrument Log, or Instrument Schem-

atic.
5. The following series of prompts display on the window requiring operator response:

a. This is the gas line clean and leak check test for inlet port [n]. Inlet ports being testedmust
be connected to a gas cylinder according to the user manual. A Nupro isolation valve
should be installed on the line between the analyzer and the regulator.

b. The test starts with amanual leak check (requires Snoop or equivalent, and IPA), then the
line and regulator are evacuated for 20minutes for cleaning. Next, the leak rate of the gas
line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shutoff valve, and isolation
valve. Check each joint for bubbleswith Snoop or equivalent. If a joint is leaking, attempt
tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe dry.
e. Close the gas cylinder valve. Leave the regulator shutoff and isolation valves open.
f. User will be needed in 30minutes to close the isolation valve. ClickOK to begin auto-

mated testing.
6. A popup window indicates the test is complete. ClickOK. The reports display.

Clean and Verify the Gas Line
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11 Troubleshooting andMaintenance

7. Click each tab across the top of the window and look for a reading of Passed. A Passed read-
ing indicates all valves are in a proper state for operation. If any test shows a Failed reading,
refer to the following table to help determine the location of the gas leak.
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Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 1

Gas Line to GasBottle
Test

This test will show a reading of Failed if any of the
other tabs has a Failed reading. Correct the failed
connection and rerun the test.

Gas Line to Inlet
Port [n]
Test 2

Gas Line to Isolation
Valve Test

Check for a leak between the gas line and the isol-
ation valve. Correct the problem and rerun the
test.

Gas Line to Inlet
Port [n]
Test 3

Isolation Valve To
Bottle LeakRate

Check for a leak between the isolation valve and
the gas cylinder. Correct the problem and rerun
the test.

If the Fail if above field indicatesFailed, one or more valves is not in the proper position. Set the
valves, then ensure the appropriate pressure is displayed on the low-pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.

1. ClickClose to close the test report. ClickClose again to close the test.
2. Repeat steps 1 through 8 for each gas line attached to the analyzer.

Clean and Verify the Gas Line

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 11 - 7



11 Troubleshooting andMaintenance

MANUAL METHOD TO CLEAN AND VERIFY GAS LINES

1. Open valves 7, 8, 9, 10, 17, 18, and the servo valve.
2. Open the port valve corresponding to the first gas line attached.
3. Wait for the vacuum gauge reading on the schematic to come down to below 10 μmHg, then

wait an additional 15minutes.
4. Close the port valve.
5. Perform steps 2 through 4 for any additional gas lines.
6. Close the open valves.
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REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. Whenworking with hazardous
gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

Replace aGasCylinder
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11 Troubleshooting andMaintenance

DISCONNECT THE DEPLETED GAS CYLINDER
1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-

wise.
2. Disconnect the gas line from the regulator. Gaswill be vented from the line. It is not necessary

to disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately
with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gaswill be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap andmove

the cylinder to an appropriate location.
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CONNECT A GAS CYLINDER

Analyzer Series Gauge should indicate
3Flex 15 psig (103 kPag)

AccuPyc 25 psig (172 kPag)

ASAP 15 psig (103 kPag)

AutoChem 15-18 psig (103 - 124 kPag)

AutoPore 50-60psig (345 - 404 kPag)

Gemini 15-18 psig (103 - 124 kPag)

TriStar 15-18 psig (103 - 124 kPag)

Regulator Pressure Settings

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder. Place the protective cap in a secure location. It will be needed to recap the gas cyl-
inder when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fittingmay cause a leak.

3. Check for leaks at the high-pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high-pressure gauge for approximately oneminute:

l If the pressure is stable, proceed with the next step.
l If the pressure decreases, tighten the regulator connector nut until it becomes stable.
If the pressure does not remain stable, remove the regulator and clean all contacts at
the regulator connection, then reinstall the regulator.

4. Purge the air from the lines.

Purge the regulator before proceeding to prevent contamination of the analysis gas sup-
ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust thePressure Control knob to approximately 5 psi.

Replace aGasCylinder
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11 Troubleshooting andMaintenance

c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both
gauges read approximately zero.

d. Close the regulator Shut-off valve to stop gas flow.
e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11mm) wrenches to tighten the gas line connection. Hold one wrench fit-

ting steady and the other to tighten the connector nut.
5. Set the analyzer pressure.

a. Turn theRegulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure. SeeRegulator Pressure Settings on the previous page.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.
d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

6. If the gas line to the instrument inlet was previously disconnected, reconnect it now.

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

See also:

Show Instrument Schematic on page 2 - 23

Use to enable themanual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go toUnit [n] > Show
Instrument Schematic.
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OIL BASED VACUUM PUMP
Log in to your customer portal to access the VacuumPumpGuide.

Oil Based VacuumPump
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11 Troubleshooting andMaintenance

PREVENTIVE MAINTENANCE

Perform the following preventivemaintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventivemaintenance procedures and
calibration be performed by aMicromeritics Service Representative every 12months.

Maintenance Required Frequency
Clean the analyzer As required or every 6months

Lubricate elevator screw As required or every 6months. Use a light coat
of lithium grease.

Check analysis port dewar Weekly

Replace sample tube O-ring As required or every 3months

Replace port filters Every 30 days

Replace vacuum pump exhaust filter* Annually (heavy usemay requiremore frequent
maintenance)

Inspect and change vacuum pump fluid* As required or every 3months

Replace alumina in oil vapor traps* (if
installed)

As required or every 3months

Replace diaphragm(s) in vacuum pump (oil
free pump only)**

Every 12months

Calibrate manifold temperature sensor Every 12months

Calibrate system volume Every 12months

Check analyzer outgassing rate Every 6months

Test analyzer for leaks As required or every 12months

Perform reference material analysis As required or every 3months

* Oil-based vacuum pumps only.

** After about 12 to 18months of operation, the diaphragm(s) in the pumpwill wear out and
become completely inoperable. To prevent any instrument downtime due to an inoperable
pump, it is recommended that you have the diaphragm(s) replaced by aMicromeritics Ser-
vice Representative every 12months.
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CHECK ANALYSIS MANIFOLD OUTGAS RATE

1. Close the supply valves (Nupro valves) on the gas inlet lines.

2. Insert leak tight plugs in unused gas inlet ports.

3. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

4. Open valves 18, 8, 17, and 7.
5. Set the servo valve to dose to 1000mmHg to ensure that it stays open.
6. Evacuate the inlet ports by opening valves 21 to 26.
7. Evacuate aminimumof 20minutes. Overnight evacuation is preferable.
8. Close valves 8 and 18.
9. Record the pressure as the Initial Reading for Inlet Ports in the following table:

Test Initial
Reading

3 Min.
Reading

Difference Limits OK?

Inlet Ports 30 μ
(0.3mmHg)

Valve 21 21 μ
(0.0021mmHg)

Valve 22 21 μ
(0.0021mmHg)

Valve 23 21 μ
(0.0021mmHg)

Valve 24 21 μ
(0.0021mmHg)

Valve 25 21 μ
(0.0021mmHg)

Valve 26 21 μ
(0.0021mmHg)

10. Wait 3 minutes, then record the pressure as the 3Minute Reading in the table.

Check AnalysisManifold OutgasRate
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11 Troubleshooting andMaintenance

11. Subtract the first reading from the second reading and record in theDifference column.
12. If the value in theDifference column is at or below the value in the Limits column, enter Yes in

OK? Column. If theDifference value is not below the Limits value, a gas inlet valve, inlet plug,
or gas line is leaking from atmosphere.

13. Close all gas inlet manifold valves (21 through 26).
14. Record the pressure as the Initial Reading, then begin timing as soon as the next step is com-

pleted.
15. Gas inlet valves 21 through 26must remain closed during this procedure. Pressurize the inlet

to valve 21 by opening the supply valve or removing the port plug. This allows gas or air to pres-
surize the inlet valve above the seat.

16. After 3minutes, record the pressure as the 3Minute Reading. Subtract the first reading from
the second and record in theDifference column.

17. Repeat steps 14 through 16 for the inlet valves 22 through 26.
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CHECK AND CLEAN THE DEWAR

When handling dewars, follow the precautions outlined inDewar Precautions on
page 6 - 1.

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Ice and suspended frost particlesmay accumulate in the bottom of the analysis port dewar. Particles
or deposits exceeding 1/4 in. in depthmay jam between the bottom of the sample tube and the
bottom of the dewar, causing the dewar not to raise fully. Accumulations of fine particles impede
liquid nitrogen circulation around the bottom of the sample tube. This causes the sample
temperature to be slightly higher which, in turn, can cause pore volumemeasurement errors in those
samples exhibiting high isotherm slope above 0.97 relative pressure. Accumulated ice is likely to melt
and form a pool of water in the dewar if all liquid nitrogen evaporates. The water must be removed,
otherwise it will solidify when liquid nitrogen is added and could press on the bottom of the sample
tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the dewar after each use. Clean
on a weekly basis.

1. Remove the dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitrogen.

Do not pour liquid nitrogen directly into a sink. Doing somay cause drain pipes to burst.

3. Rinse the dewar with warmwater to melt any remaining ice accumulation whichmay remain.
Dry thoroughly.

4. Replace the dewar.

Check and Clean the Dewar
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11 Troubleshooting andMaintenance

CLEAN THE ANALYZER

The exterior casing of the analyzer may be cleaned using a clean cloth dampened with isopropyl
alcohol (IPA), amild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive
cleaner.

l Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

l Use only amild detergent in water to clean safety shields. The use of isopropyl alco-
hol can damage the shield surface.
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ENABLE MANUAL CONTROL

Unit [n] > Enable Manual Control

See also:

SeeShow Instrument Schematic on page 2 - 23.

Use to enable themanual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go toUnit [n] > Show
Instrument Schematic.

EnableManual Control
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11 Troubleshooting andMaintenance

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. Whenmanual control is
disabled, closed valves appear white.

Analyzer Schematic Icon Table
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Icon or Symbol Description
Servo Valve. Closed.

Servo Valve. Open.

Elevator.

The arrow inside the dewar icon indicates the direction of dewar move-
ment.

The elevator icon indicates the position of the dewar.

Sample Tube.Cannot bemanually controlled.

P0 (Psat) tube.

Transducers Each sample port and P0 port contains a 1000mmHg transducer. The
transducer readings display next to the ports.

Displays the temperature, the 1000mmHg,
10 mmHg transducer readings, and vacuum gauge
pressure.

The 10mmHg transducer (for krypton or Micropore
installations).

Displays themicropore transducer reading. This
transducer is optional and is shown only if installed.

Analyzer Schematic Icon Table (continued)

EnableManual Control
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11 Troubleshooting andMaintenance

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If the
elevator starts to vibrate or becomes noisy when traveling, contact aMicromeritics Service
Representative for disposition.
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PORT FILTERS

Replace Port Filters

A porousmetal filter is located in the analysis port and in each degas port. Using a contaminated filter
on the analysis port may extend the time required to achieve a vacuum at that port and the
contaminant may also adsorb or desorb during analysis, affecting the analysis results. A
contaminated filter on the analysis port may be detected by a leak test (if the contaminant outgasses)
or by a free space readingmuch lower than normal.

Replace the Analysis Port Filter

A porousmetal filter is located in each analysis port. Using a contaminated filter on an analysis port
may extend the time required to achieve a vacuum at that port. More importantly, the contaminant
may adsorb or desorb during analysis, affecting the analysis results. A contaminated filter on an
analysis port may cause a leak test to fail (if the contaminant outgasses) or cause a free space
reading to bemuch lower than normal.

Before replacing a port filter, ensure that the port valve is closed. Observe the analysis
system schematic to verify valve status.

To avoid analysis problems, the new filter andO-ringmust be clean.Wear gloveswhen
performing this task. Do not touch the parts with bare hands.

1. Use a wrench to remove the sample tube fitting from the analyzer.

Port Filters
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11 Troubleshooting andMaintenance

2. Remove and replace the filter andO-ring.
3. Reinstall the analysis port fitting. Securely tighten with a wrench to prevent leaks during evac-

uation.

Replace Degas Port Filter

To avoid degassing problems, the new filter andO-ringmust be clean. Do not touch
themwith bare hands.

1. Use a wrench to remove the degas port fitting, filter, andO-ring.
2. Replace the filter and theO-ring.
3. Carefully reassemble the sample tube fitting, filter, O-ring, andmanifold connector. Hand

tighten, then tighten with a wrench.

REPLACE THE PSAT TUBE O-RING

1. Turn the connector nut counter-clockwise to loosen.
2. Pull the connector nut downward.
3. Gently pull the Psat tube downward to remove it from the Psat port.
4. Remove theO-ring from the Psat tube and replace with a new one.
5. Insert the Psat tube into the Psat port.
6. Slide the connector nut up to the Psat port and turn the connector nut clockwise to tighten.

11 - 24 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



REPLACE THE SAMPLE TUBE O-RING

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomesworn or cracked, it does not provide a good seal and will need to be replaced. This
procedure applies to both degas and analysis ports.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

1. Carefully remove the dewar from the elevator. Take care not to bump the sample tube bulbs
with the dewar during this process. Place the dewar aside.

2. Hold the sample tube firmly with one hand and loosen the sample tube connector nut by turn-
ing counter-clockwise.

Do not allow the sample tube connector nut to drop onto the sample tube bulb as it may
break the tube.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp
the sample tube with both hands.

4. Remove theO-ring from the top of the sample tube and replace it with a new one.

Replace the Sample TubeO-ring
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11 Troubleshooting andMaintenance

If the O-ring remains inside the sample port, use a pair of tweezers or needle-nose pliers
to remove it.

5. While holding the connector nut in place, slide a new O-ring over the sample tube, about
1/4 in. from the top of the tube.

11 - 26 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



6. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully
seated.

7. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule andO-ring will move along with the connector nut). Then, turning clockwise, hand
tighten the connector nut to the sample connector.

Replace the Sample TubeO-ring
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11 Troubleshooting andMaintenance

POWER ANALYZER ON AND OFF

DO NOT connect or disconnect cables when the analyzer is poweredON.

If a Smart VacPrep is used, it is recommended that the power to the Smart VacPrep remain ON
when the analyzer is powered on. If it does become necessary to power off the Smart VacPrep, exit
the analyzer program first. Restart the analyzer program, then power on the Smart VacPrep.

Power ON the equipment in the following order:

1. Computer, monitor, and printer
2. Analyzer
3. External vacuum pump (the pumpmust warm approximately two hours before performing ana-

lyses)
4. Degasser

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gresswhen closing the application, the followingmessage is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print manager
will print. If a power failure occurs and an uninterruptible power supply (UPS) is not attached
to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer
3. Analyzer
4. External pump
5. Smart VacPrep
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PERFORM A LEAK TEST
Unit [n] > Diagnostics > Start Diagnostic Test
AMicromeritics Service Representativemay request that a leak test be performed to determine if
there is a system leak andmay also require a copy of the report generated by this test.

The test provides:

l Prompts on preparing the analyzer for the test
l Approximate time period of the test
l Prompts in which an operator response is required

1. Select the test to run.
2. SelectReport After Analysis and choosePreview as the destination.
3. ClickStart.
4. Verify all tests have aPassed status by selecting the tabs and looking for thePassed status for

each test run.
5. ClickSave As to save the test file results.

Perform a Leak Test
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RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progresswhen
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected during
the analysis will still be present, but the analysis should be restarted in order to produce complete
results.

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trainedMicromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If a menu item is grayed out, it is usually an indication that Service Test Mode is required.

To exit Service Test Mode, go toOptions > Service Test Mode and deselect theService Test
Mode option or close the application.

Recover from a Power Failure
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A ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable tomembers of
the Developer group only.

See also:

Mic Module Python Calls on page A - 15

Themic Pythonmodule is automatically imported when running a user supplied script. Themodule
provides access to primary and overlay isotherm data and provides support for summary, tabular,
and graphical reports.

l Summary reports.Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

l Tabular reports. Consist of one or more tables each containing one or more labeled columns of
data. Tabular reports are created with themic.table call.

l Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMicModule Python Calls section of this
appendix. More advanced example python scripts are included in the analyzer software. Application
specific discussions can be found on http://www.micro-report.com

The examples in this topic are also included as a part of theMicromeritics installation pro-
cess and are located in theScripts sub-directory.

A Advanced Reports - PythonModule
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A Advanced Reports - PythonModule

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports a
"mic" Pythonmodulemust be created. SeeMic Module Python Calls on page A - 15 for an
example of Python script and functions for the "mic" Pythonmodule.

1. Create the Python script and save it in theScripts directory.
2. Open a sample file with aCompleted status.
3. SelectAdvanced in the drop-down list at the bottom of the window to return to the tabbed

view.
4. On theReport Options tab, selectAdvanced (orUser-Defined) in theSelected Reports list

box, then clickEdit.
5. On theAdvanced Report Optionswindow, clickAdd in theAvailable Scripts group box to loc-

ate and select the Python script. Repeat for each script to be added.

6. In theSelected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in theAvailable Scripts box.

7. ClickPressures to add pressure points to the report. ClickOK to return to theReport Options
tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On theReport Options tab, clickPreview. The Python Reports will be included on the tabs

across the top portion of theReportswindow.
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Field or Button Description
Add [button] Click to add additional Python reports.

Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace, edit,
or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 4.

Advanced Reports

SCRIPTS

RUN A SCRIPT
1. Open a sample file with aComplete file status.
2. SelectAdvanced in the drop-down list at the bottom of the window.
3. Select theReport Options tab.
4. HighlightAdvanced in theReports list box, then clickEdit.
5. On theAdvanced Report Optionswindow, clickAdd. Locate and select one or more python

scripts then clickSelect. The selected scripts become a part of the drop-down list in theAvail-
able Scripts section of theAdvanced Report Optionswindow.

6. In theSelected Reports section, select up to five Advanced reports in the drop-down lists. Use
thePressures button to include or exclude available pressures in the report.

7. ClickOK.
8. ClickPreview on theReport Options tab to view all reports selected in the previouswindow.

Scripts
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EDIT A SCRIPT

When a script is added, the code is stored within the application. If the script changes out-
side of the application, the script file will have to be re-added to the Advanced Report
Optionswindow for the changes to take affect.

Field or Button Description
Add [button] Adds one or more scripts to theAvailable Scripts box. The added

scripts then become available as options in theSelected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button] Select to include or exclude pressures from the report.

l Calculation pressure range.Enter theminimumandmaximum
pressures to be used in the pressure table.

l Cancel. Discards any changes or cancels the current process.
l Exclude All. Select to exclude all pressure points in the table.
l Include All. Select to include all pressure points in the table.
l OK. Saves and closes the active window.

Remove [button] Removes the script from theAvailable Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script name
remains the same.

REMOVE A SCRIPT
Select the script in theAvailable Scripts box then clickRemove. The script is removed from the
application however, the original .py text file is not affected.
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SUMMARY REPORT
This script produces a summary report with two summaries:

import mic
mic.summary( "My Summaries" )

mic.summary.add( "Summary A",
["label 1:", "label 2:", "label 3:"],
["val1", "val2", "val3"] )

mic.summary.add( "Summary B",
["label 4:", "label 5:", "label 6:"],
["val4", "val5", "val6"] )

The result is:

SummaryReport
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A Advanced Reports - PythonModule

TABULAR REPORT
If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.NOTE: This script uses the Python package "numpy" and c-style
formatting of the numerical values.

import mic
import numpy as np

mic.table("My Tables")

mic.table.addtable( "My set A" )
mic.table.addcolumn( "x", ["1.0", "2.0", "3.0"] )
mic.table.addcolumn( "y", ["0.5", "1.0", "1.5"] )

x1 = 0.2
x2 = 0.5
x3 = 3.14159/2
mic.table.addtable( "My set B" )
mic.table.addcolumn( "x", ["%8.3f" % x1,

"%8.3f" % x2,
"%8.3f" % x3 ] )

mic.table.addcolumn( "sin(x)", ["%8.3f" % np.sin(x1),
"%8.3f" % np.sin(x2),
"%8.3f" % np.sin(x3)] )

mic.table.addcolumn( "cos(x)", ["%8.3f" % np.cos(x1),
"%8.3f" % np.cos(x2),
"%8.3f" % np.cos(x3)] )

The result is:
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GRAPHIC REPORT
This script is an example of themicmodule producing a graph with two curves:

import mic
import numpy as np

mic.graph( 'My Graph', 'x', 'f(x)' )

myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )
mic.graph.add( 'x^2', myx, myx*myx, marker='o' )
mic.graph.add( 'sin(x)', myx, np.sin(myx), marker='^' )

The results are:

Graphic Report
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ACQUIRE BASIC INFORMATION
To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic.isotherm,mic.sample_information andmic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

import mic

prel, qads, n_ads, ambient_fs, analysis_fs, mass, desc = mic.isotherm('rel')
mic.graph( 'Graphical Report 1', 'Rel. Press', 'Quantity Adsorbed' )
mic.graph.add( 'Sample isotherm', prel, qads )

pabs, qads, n_ads, ambient_fs, analysis_fs, mass, desc = mic.isotherm('abs')

mic.graph( 'Graphical Report 2' 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('Sample Isotherm', pabs, qads)

mass = mic.sample_information('sample mass' )
Tanl = mic.sample_information('analysis temperature' )
dens = mic.sample_information('sample density')

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",

[ "Number of adsorption points:",
"Ambient Free space:",
"Analysis Free space:" ,
"Sample mass (g):",
"Description:",
"Analysis Temp:",
"Sample Density (g/cm^3):" ],

[ "%8.3f" % n_ads,
"%8.3f" % ambient_fs,
"%8.3f" % analysis_fs,
"%8.3f" % mass,
desc,
"%8.3f" % Tanl,
"%8.3f" % dens ] )

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",

"Hard Sphere Diameter",
"Density Conversion Factor",
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"Molecular Weight",
"Analysis gas"],

[ "%8.3f" % csa,
"%8.3f" % hsd,
"%8.3f" % dcf,
"%8.3f" % mol_weight,
analysis_gas ] )

Note the calls tomic.isotherm andmic.adsorptive_data above are each returning results as a list with
elements of varying return type.

Acquire Basic Information
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ACQUIRE REPORT RESULTS
Sample file report resultsmay be accessed using themic.report call. This script prints a summary of
the results of the t-plot and BET reports.

import mic

sa = mic.report("bet", "surface area")
c = mic.report("bet", "bet constant")
vm = mic.report("bet", "monolayer capacity")
esa = mic.report("tplot", "external surface area")
vol = mic.report("tplot", "micropore volume")

mic.summary( "BET and T-plot Results" )

mic.summary.add( "Report Results",
[ "bet surface area",

"bet constant",
"bety 6" ,
"tplot external surface area",
"tplot micropore volume"],

[ "%10.5f" % sa,
"%10.5f" % c,
"%10.5f" % vm,
"%10.5f" % esa,
"%10.5f" % vol ] )

The result is:

Acquiring the results from a pore-distribution report such as the BJH method is done in a similar way
as in the previous script except the return values from themic.report call are slightly different since
they involve lists of data. For example,

import mic
xdat, ydat, desc = mic.report('bjhads' ,'incremental distribution' )
mic.graph( 'BJH Ads/Des', 'Pore diameter', 'Incremental Volume' )
mic.graph.add( desc, xdat, ydat )
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The result is:

See theMic Module Python Calls section for amore complete description of the usage and scope of
themic.report call.

Acquire Report Results
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ACQUIRE OVERLAY SAMPLE DATA
The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report and
mic.adsorptive_data have a very similar interface as themic.overlay call, and a summary of their
usage is shown in the example in this topic.

import mic

p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')

mic.graph( 'Three Sample Isotherms',
'Rel. Press',
'Quantity Adsorbed (cm^3/g)' )

mic.graph.add( 'Primary Isotherm ', p, q )
mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
mic.graph.add( 'Overlay Isotherm 2', p2, q2 )

mic.summary( "A summary report" )

mic.summary.add( "Two samples",
[ "Primary Sample:",

"Overlay Sample 1:",
"Overlay Sample 2:" ],

[ desc,
desc1,
desc2] )
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The results are:

To enable the use of overlay data in the Advanced reports, the following two actionsmust be taken
prior to running the script:

l Sample files to overlaymust be selected, and
l TheOverlay samples checkbox on theAdvanced Report Optionswindow must be selected

Acquire Overlay Sample Data
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ENABLE THE USE OF OVERLAY DATA
1. On theReport Options tab, clickOverlays.
2. On thePlot Overlay Sample Selectionwindow, tomove a file from theAvailable Files list box

to theSelected Files list box, either double click a file name in theAvailable Files list box or
click one or more files in theAvailable Files list box then clickAdd.

3. ClickOK.
4. On theReport Options tab, highlightAdvanced in theSelected Reports list box.
5. ClickEdit to the left of theSelected Reports list box.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found inScripts on page A - 3.
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MIC MODULE PYTHON CALLS

TABLES

AvailableMic Python calls for tables:

l Create a new tabular report
l Add a column
l Add a table

ADD A TABLE
This script adds a table to the last created tabular report:

mic.table.addtable( name )

Keyword arguments:

name --- the table name

ADD A COLUMN
This script adds a column to the last created table:

mic.table.addcolumn( header, values )

Keyword arguments:

header --- column header; must be a string (or convertible)
values --- column values; must be a list of strings (or convertible)

CREATE A NEW TABULAR REPORT
mic.table( title='User Table' )

Keyword arguments:

title --- the tabular report title (default = 'User Table')

MicModule Python Calls
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SUMMARY REPORTS

AvailableMic Python calls for summary reports:

l Add a summary section to the last created summary report
l Create a new summary report

ADD A SUMMARY SECTION
This script adds a summary section to the last created summary report:

mic.summary.add( name, labels, values )

Keyword arguments:

name --- summary section name
labels --- column of labels; must be a list of strings

(or convertible) and the same length as values
values --- column of values; must be a list of strings

(or convertible) and the same length as labels

CREATE A NEW SUMMARY REPORT
mic.summary( title='User Summary' )

Keyword arguments:

title --- the summary title
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GRAPHIC REPORTS

AvailableMic Python calls for graphic reports:

l Add a curve
l Add a curve using the second y-axis
l Create a new graphic report

ADD A CURVE
This script adds a curve to the last created graphical report:

mic.graph.add( name, x, y, yyaxis=False, color=None, linestyle='-', mark-
er='a', graphtype='both' )

Keyword arguments:

name --- the curve name
x --- list of x values; must be a list of floats

(or convertible) and the same length as y
y --- list of y values; must be a list of floats

(or convertible) and the same length as x
yyaxis --- place this curve on the yy-axis if True

otherwise place on the y-axis (default = False)
color --- RGB color as an HTML hex string (e.g., '#4169e1')

or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)

linestyle --- line style; (default = '-')
'-' : solid
'--' : dash
'.' : dot
'-.' : dash dot
'-..' : dash dot dot

marker --- marker shape; (default = 'a')
'+' : plus
'o' or '0' : circle
'x' : cross
'^' : up triangle
'v' : down triangle
's' : square
'd' : diamond
'8' : hourglass
'~' : horizontal hourglass
'' or None : no marker
'a' : automatically selected

Graphic Reports

MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018 A - 17



A Advanced Reports - PythonModule

graphtype --- graph type; (default = 'both')
'curve' or 'c' : curve
'points' or 'p' : points
'both' or 'b' : curve-and-points
'hist' or 'h' : histogram

ADD A CURVE USING THE SECOND Y-AXIS
This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy( name, xx, yy )

Add a curve to the last created graphical report using the second
y-axis. The arguments to this call are the same as to mic.graph.add
with the argument

CREATE A NEW GRAPHICAL REPORT
mic.graph( title='User Graph', xlabel='X axis', ylabel='Y axis', yylabel='YY
axis', xlinear=True, ylinear=True, yylinear=True )

Keyword arguments:

title --- the graphical report title (default = 'User Graph')
xlabel --- x-axis label (default = 'X axis')
ylabel --- y-axis label (default = 'Y axis')
yylabel --- yy-axis label (default = 'YY axis')
xlinear --- x-axis linear scale; if false, use log scale

(default = True)
ylinear --- y-axis linear scale; if false, use log scale

(default = True)
yylinear --- yy-axis linear scale; if false, use log scale

(default = True)

GET PRIMARY ISOTHERM DATA
mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:
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p, qads, num_ads, ambient_fs, analysis_fs, mass, desc = mic.overlay(1,
'rel')

p --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

qads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads --- number of points in the adsorption curve;
0 if overlay is unavailable

ambient_fs --- ambient free-space; 0.0 if overlay is unavailable
analysis_fs --- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

GET OVERLAY ISOTHERM DATA
mic.overlay( overlay_number = 1, press_type='rel' )

Keyword arguments:

overlay_number --- the overlay number (1 through 8; default = 1)
press_type --- the pressure basis; use 'rel' for relative pressure,

'abs' for absolute (default = 'rel')

Usage:

p, qads, num_ads, ambient_fs, analysis_fs, mass, desc = mic.overlay(1,
'rel')

p --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

qads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads --- number of points in the adsorption curve;
0 if overlay is unavailable

ambient_fs --- ambient free-space; 0.0 if overlay is unavailable
analysis_fs --- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

Get Overlay IsothermData
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GET ADSORPTIVE DATA FOR EACH SAMPLE
mic.adsorptive_data( sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the adsorptive data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)

csa --- cross sectional area (nm^2)
hsd --- hard sphere diameter (angstroms)
dcf --- density conversion factor (dimensionless)
mol_weight --- molecular weight
analysis_gas --- mnemonic for the analysis gas species

(e.g., 'CO', 'H2')

GET SAMPLE INFORMATION ITEM
mic.sample_information( item, sample_number = 0 )

Keyword arguments:

item --- string identifying the item to be returned.
Accepted identifiers are

'sample mass'
'sample description'
'analysis temperature' (degrees Kelvin)
'sample density' ( g/cm^3 )

sample_number --- Sample to retrieve (default = 0).
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

mass = sample_information('sample mass')
mass = sample_information('sample mass',0)
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GET REPORT RESULTS

This script gets report results for the indicted report and sample:

mic.report( report_name, result, sample_number = 0 )

Keyword arguments:

sample_number --- Identifier for the sample data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file

Usage:

sa = mic.report( 'bet' , 'surface area' )
porewidth, incvol, desc = mic.report( 'bjhads' ,

'incremental distribution' )

The available report keywords, result keywords and a corresponding
description of the result is listed in the table below:

Report keyword Result keyword Description
-------------- -------------- -----------

bet surface area Surface area ( m^2/g )
bet bet constant BET constant ( dimensionless )

bet monolayer capacity Monolayer capacity ( cm^3/g )
tplot external surface area External surface area (m^2/g)
tplot micropore volume Micropore volume (cm^3/g)
bjhads incremental distribution Incremental Distribution
bjhdes incremental distribution Incremental Distribution
dhads incremental distribution Incremental Distribution
hk incremental distribution Incremental Distribution
dft incremental distribution Incremental Distribution
nldft incremental distribution Incremental Distribution

where the incremental pore distribution result above (for those
reports which return this) is a list with three components being,

porewidth --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

incvol --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.

Get Report Results
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A Advanced Reports - PythonModule

GET IMPORTED PORE DATA
mic.imported_pore_data( import_number = 1 )

Keyword arguments:

import_number --- the import number (1 through 8)

Usage:

xdat, ydat, desc = mic.imported_pore_data(1)

xdat --- array of pore dimension boundaries (angstroms);
empty-array if unavailable.

ydat --- array of incremental pore volumes (cm^3/g);
empty-array if unavailable.

desc --- Name of data set; empty-string if unavailable.
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B DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of amodel that can be
visualized and describedmathematically. Earlymodels of physical adsorption were quite simple,
both conceptually andmathematically, for very practical reasons— hand computationswere
required. Todaywe can explore complexmodels that describe adsorption systems on the atomic
scale of size and sub-picosecond time frame. This is not because scientists are smarter, but because
of available tools. The DFTmodels are created by classical approaches to adsorption aswell as
models based onmodern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group aremethods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isothermswith an
isotherm equation containing a small number of parameters. At aminimum, these parameters
include the extent of the surface, such as themonolayer capacity (Vm), and themolar intensity of the
gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbedmolecules with
each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters for the
effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use amolecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to themicroscopic
properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size,
the pore geometry, and the temperature.

The following example is given so that youmay understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded over
time. In this situation, the pressure falls rapidly from its initial value and gradually approaches a
steady reading, called the equilibrium pressure. The amount adsorbed corresponds to the
quantity of gas effectively removed from the gas phase by the solid surface. A graph that plots
amount adsorbed versus equilibrium pressure is called an adsorption isotherm.

B DFTModels
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B DFTModels

Under such conditions, the argon atoms that randomly enter the pore space feel the presence of
the solid surface as the action of an external attractive force (the dispersion forces or Van der
Waal’s forces) and spendmore time near the surface. As a result, the space near the surface
acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a function
of pressure and themolecular properties of the components of the system, then amodel could
be constructed for the adsorption isotherm for the system. Modern physical chemistry provides
several ways to calculate this distribution. All thesemethods are based on the fundamental
thermodynamic law that such a system adopts a configuration of minimum free energy at
equilibrium. Also needed is a description of the pairwise interaction energy between atoms, U(s),
commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptivemolecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gasmolecules in a
system in equilibrium: themolecular dynamicsmethod and theMonte Carlo method. Both of these
are used as referencemethods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In themolecular dynamicsmethod, the position and velocity of individual gas particles are calculated
over time at very short intervals. Thismethod takes into account both the forces acting between the
gas particles themselves and those acting between the gas particles and the atoms of the simulated
surface. As the simulated particles collide with each other and with the surface, the average
concentration of particles in the space near the surface is calculated; this calculation yields the
amount of gas adsorbed.

Thismethod can be thought of as a way to determine the chronological record of themovement of
each particle in the system using time steps of 10-14 seconds. Although themathematics are simple,
the number of calculations required for a system of even a few hundred particles is astronomical and
challenges even the fastest computers.
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MONTE CARLO METHOD

In theMonte Carlo method, determination of the system equilibrium distribution begins with an
assumption (whichmay be only approximate) about the initial configuration of particles in the system.
The system is “equilibrated” through a process of randomly selecting one particle and conditionally
moving it a random distance in a random direction.

If themove results in a configuration of lower total energy, then themove is completed and another
particle is randomly selected to bemoved.

If themove results in a configuration of higher energy, a probability for that event is calculated, and a
random number between zero and one is generated. If the generated number is smaller than the
probability of the event, then themove is accepted; otherwise, another particle is selected and the
process is repeated. This process continues until the average total energy of the system no longer
decreases; at this point, average configuration data are accumulated to yield themean density
distribution of particles in the system.

Monte Carlo simulations require considerably less computation time thanmolecular dynamic
simulations and can yield the same results; however, neither method provides a really practical way
to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to bothmolecular dynamic andMonte Carlo
simulations.When compared to referencemethods based onmolecular simulation, this theory
provides an accuratemethod of describing inhomogeneous systems yet requires fewer calculations.
Because the density functional theory provides accuracy and a reduced number of calculations, it is
the basis embodied in the DFTmodels.

The system beingmodeled consists of a single pore represented by two parallel walls separated by a
distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of
constant density; its chemical potential1 ) is determined by the pressure of the system using well-
known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energywith respect to density (or concentration).

Models Based on Statistical Thermodynamics
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B DFTModels

As noted previously, at equilibrium, the whole system has aminimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory describes
the thermodynamic grand potential as a functional of the single-particle density distribution;
therefore, calculating the density profile that minimizes theGPE yields the equilibrium density profile.
The calculationmethod requires the solution of a system of complex integral equations that are
implicit functions of the density vector. Since analytic solutions are not possible, the problemmust be
solved using iterative numerical methods. Although calculations using thesemethods still require
supercomputing speed, the calculation of many isotherm pressure points for a wide range of pore
sizes is a feasible task. The complete details of the theory and themathematics can be found in the
papers listed underDFT Model References on page B - 17.

The following graphs and accompanying text illustrate the results of using density functional theory to
predict the behavior of amodel system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise distribution
of adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area
under the profile curve represents the amount adsorbed per unit area at this pressure. The positions
of themaxima are separated by a distance determined by the size of the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the
integral over the profile. Repeating this calculation over a range of pressures yields the adsorption
isotherm for themodel. If the value of H is very large, the isotherm obtained corresponds to that of an
external, or free, surface. If H is smaller, a range of pressures is reached where twominima exist for
the grand potential, showing the presence of twometastable phases having different density
distributions but the same chemical potential. The phase with the lower GPE is the stable one. As the
pressure is increased, a point is reached where the other phase becomes the stable one. This phase
transition reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the
critical pore-filling pressure. This pressure is analogous to the condensation pressure predicted by
the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for amodel pore with H = 40 angstroms. The
inset shows the density profiles for the corresponding points of the isotherm.

Figure 2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is amirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to
the surface.

l Inset a shows the profile corresponding to point a on the isothermwhere the surface is about half
covered.

l At point b, the first layer is so full that it ismore favorable for atoms to start a new layer.
l At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In
inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or
5molecular diameters from the surface.

l Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of
the pore, indicating a phase transition.

Models Based on Statistical Thermodynamics
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B DFTModels

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores are
shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-filling
pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K

Figure 4 showsmodel isotherms for pores in themicropore size range. Note the logarithmic scale for
pressure.

Figure 4. Model Isotherms in the Micropore Size Range of Pore Width Argon on Carbon at
87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1millitorr.
Pores below 15 Å fill before amonolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using themethods of non-local density functional theory, two sets of isotherms have been calculated
to serve as kernel functions for the characterization of porous solids from adsorption data. Themodel
isotherms are stored in binary format files. Thesemodels assume a slit-like pore geometry. The pore
size range from 4.0 to 4000 Å is covered in 91 classes in a geometric progression. The class intervals
are rounded to the nearest 0.02molecular diameters. A model for the free or external surface is
included to account for unfilled pores. Each of the 92model isotherms has been calculated at 181
pressure points from near 1×10-6 to near 1.00 relative pressure.

Thesemodels are identical to those supplied with the original DOS version of DFT software. Some
slight difference from the DOS resultsmay be noted when they are applied to the same data due to
improvements in the deconvolution algorithm and better regularization of the current software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Using themodified Tarazona prescription described byOlivier (seeDFT Model References on
page B - 17 [items 3 and 4]), model isothermswere calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. Themodel makes no provision for pore filling in themicropore
region. If the sample solid contains small mesopores, the isotherm data should be truncated (using
theSelect Data Pointswindow) to a suitably low relative pressure to avoid trying to fit this region;
mesopore filling reports as a large area of low energy in the calculated distribution of adsorptive
potential.

Models Based on Statistical Thermodynamics
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The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas andMCM-41mesoporous silicas aswell as
zeolites. The pore-filling pressureswere determined as a function of the pore size from adsorption
isotherms onMCM-41materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2model reports pore sizes ranging from 3.8 to 387 Å and the AR model from 3.8
to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the Accur-
ate Pore Size Analysis of MCM-41 andOther Silica-BasedMesoporous
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isothermswere calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference samples
of montmorillionite. The constructionmethod for the hybrid models was analogous to that described
in the first reference below (Jaroniec et al,1999). The additional references add additional theoretical
details as well as examples of the application of themodel to pillared clay catalysts. Thismodel
reports pore widths from 3.8 to 387 angstroms.

References: Mietec Jaroniec, Michal Kruk, JamesP. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128,Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

JamesP. Olivier andMario L. Occelli, “Surface Area andMicroporosity of a
Pillared Interlayered Clay (PILC) from aHybrid Density Functional Theory
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(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3), 623-
629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore VolumeDistribution, and Acidity in Mesoporous Expanded Clay
Catalysts fromHybrid Density Functional Theory (DFT) and Adsorption
MicrocalorimetryMethods,” Langmuir 2002, 18, 9816-9823.9b.

JamesP. Olivier, “The Importance of Surface Heterogeneity in Developing
CharacterizationMethods.” 6th International Symposium on the
Characterization of Porous Solids, Studies in Surface Science and Catalysis
144, Elsevier, 2002.

JamesP. Olivier andMario L. Occelli, “Surface Area andMicroporosity of
Pillared Rectorite Catalysts from aHybrid Density Functional Theory
Method,”Microporous andMesoporousMaterials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isothermswere calculated using the non-local prescription of Tarazona, employingmolecular
parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

Thismodel was produced in the samemanner as the N2Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Models Based on Statistical Thermodynamics
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Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for a
silica or alumina surface.

Thismodel file is particularly useful for sizing zeolites or zeolite containingmaterials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. Thesemodels are slightly different fromN2-DFT
and Ar-DFTmodels that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of
6.

Thismodel is particularly useful for microporous carbonmaterials. The reported pore size range is
from 3.5 to 250 angstroms.
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References: Jacek Jagiello and JamesP. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isothermswere calculated using the samemethods and assumptions that were used in the
model above except in thismodel, the aspect ratio is equal to 12.

These two finite poremodelsmay be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electronmicroscopy (HRTEM) and/or X-
ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and JamesP. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the graphitic surface of an
infinitely long cylinder.

Thismodel is particularly useful for characterizing carbon single-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

Models Based on Statistical Thermodynamics
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N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule andmultiple concentric graphitic
surfaces of infinitely long cylinders.

Thismodel is particularly useful for characterizing carbonmulti-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the oxide surface of an infinitely
long cylinder.

Thismodel is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K
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Model isothermswere calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gasmolecule and the oxide surface of an infinitely
long cylinder.

Thismodel is similar to themodel above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distributionmay be evaluated using classical
approaches tomodel kernel functions for use with equation (1) of the DFT Theory. (Log in to your
customer portal to access the Calculations document.) Be aware that the deconvolutionmethod only
provides a fittingmechanism; it does not overcome any inherent shortcomings in the underlying
theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution ismostly of historical interest.
At aminimum, the equationmust contain a parameter dependent on adsorption energy and another
dependent onmonolayer capacity or surface area. This is sufficient to permit the calculation of the
set of model isotherms that is used to create a librarymodel. The Langmuir equation has been used
in the past, as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these
suffer from the fact that they only describemonolayer adsorption, whereas the datamay include
contributions frommultilayer formation.

PORE SIZE
It is well established that the pore space of amesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure, this
knowledge can be used to characterize themesopore size distribution of the adsorbent. The
correlating functionmost commonly used is the Kelvin equation. Refinementsmake allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the pore
wall.

Models Based on Classical Theories
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The commonly used practical methods of extractingmesopore distribution from isotherm data using
Kelvin-based theories, such as the BJH method, were for themost part developed decades ago and
were designed for hand computation using relatively few experimental points. In general, these
methods visualize the incremental decomposition of an experimental isotherm, starting at the highest
relative pressure or pore size. At each step, the quantity of adsorptive involved is divided between
pore emptying and film thinning processes and exactly is accounted for. This computational
algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If the thickness
curve used is too steep, it finally will predict a larger increment of adsorptive for a given pressure
increment than is actually observed; since a negative pore volume is non-physical, the algorithm
must stop. Conversely, if the thickness curve used underestimates film thinning, accumulated error
results in the calculation of an overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions
corresponding to various classical Kelvin-basedmethods have been calculated for differing
geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K
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The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Harkins and Jura Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins andG. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

Models Based on Classical Theories
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B DFTModels

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the International
Symposium on Surface Area Determination, D.H. Everett, R.H. Ottwill,
eds., U.K. (1969).

B - 16 MicroActive ASAP 2460Operator Manual
246-42800-01 (Rev F)— 2018



DFT MODEL REFERENCES
The papers listed below provide additional information on DFTmodels:

1. “Determination of Pore Size Distribution fromDensity Functional TheoreticModels of Adsorp-
tion and Condensation within Porous Solids,” J.P. Olivier andW.B. Conklin, Micromeritics
Instrument Corp; presented at the International Symposium on the Effects of Surface Hetero-
geneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July 1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shapedGeometry,” Perla
B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier Science Pub-
lishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of PorousMaterials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity UsingModel IsothermsCalculated by
Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference on
the Fundamentals of Adsorption, Pacific Grove, CA (1995).

DFT Model References
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D FREE SPACE CORRECTION
Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of gas
dosed into the sample tube is calculated from the difference in pressures in themanifold before and
after the dose is delivered. The quantity of gas adsorbed by the sample is calculated by subtracting
the quantity of gas remaining in the free space of the sample tube after equilibrium is established
from the quantity of gas originally dosed into the sample tube. Free spacemust be determined
accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gasmanifold joined to a sample tube by an isolation
valve. Themanifold section has connections for an absolute pressure transducer, a temperature
gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A dewar flask
containing a cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it can be raised to
immersemost of the sample tube. Two temperature zones exist within the sample tube when
immersed in the cryogenic bath: a warm zone (the volume above the liquid level and near ambient
temperature) and a cold zone (the volume below the liquid level at cryogenic temperature). Not only
must the total free space volume be determined, but it also is necessary to determine the quantity of
gas residing within the “cold” zone since a nonideality correctionmust be applied to only that quantity
of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zoneswith a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal themolar volume of gas contained in the cold zone and
the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the followingmethods for free space determination:

l Measure
l Calculate
l Enter

MEASURE

Generally, thismethod, although requiring a little more time (approximately 10minutes), is themost
preferred one for determining free space. It is simple, automatic, requires very little information, and
essentially is error-proof. With thismethod, the instrument first evacuates themanifold and sample
tube (containing sample), then isolates the sample tube by closing the valve. Then themanifold is
charged with helium, the pressuremeasured, and the valve opened allowing the helium to expand
into the sample tube at ambient temperature. Again the pressure ismeasured.

D Free Space Correction
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D Free Space Correction

The dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure drops;
when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces are
calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3) measured
pressures. From these, the value of the portion of analysis free space at cryogenic temperature
which requires correction for nonideality can be determined.

Thismethodmay be undesirable if:

l Helium is unavailable; free space determination by the analyzer requires the use of helium.
l Analysis speed is amajor factor; a helium free spacemeasurement of 10 to 15minutes is
required.

l The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs
helium.

CALCULATE
Thismethod is themost rapid and efficient way of compensating for free space. Ensure the following
is accomplished:

l Perform a blank analysis on the sample tube.
l Load the blank analysis file data into the sample tube file.
l Enter the analysis bath temperature (found on the p° and Temperaturewindow).
l Enter the samplemass and density (found on theSample Description tab).

ENTER
Thismethod allows for entering predetermined values for the ambient and analysis free spaces. The
values to enter may be obtained in one of two ways:

l A pre-analysis free space calibration of the sample tube containing sample.
l The total free space of an empty sample tube ismeasured and the displacement of the sample cal-
culated from itsmass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in caseswhere the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the samewhen the analysis is performed as
it waswhen gathering data for free space calculations.
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E MAINTAIN HIGH PURITY GASES

The analysis systemwas designed to accuratelymeasure the surface area of all types of materials. It
is important that the gases (especially krypton) used for thesemeasurements be of highest purity,
especially when analyzing low surface area samples. Three ways to ensure high purity gases are to
alwaysmaintain:

l thoroughly purged gas pressure regulators
l non-permeable gas lines
l leak-free connections

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areaswith decreasing quantities of sample. The analyzer
uses very small amounts of helium; therefore any residual air in the regulator can distort results of
subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high purity gases (particularly
helium):

l Usemetal gas lines only
l Remove trapped air from the regulator and gas lines

USE METAL GAS LINES
Always usemetal gas lineswhich have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at amuch faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR
When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high- and low-
pressure sides of the regulator, as well as in the gas lines. Remove asmuch of this air as is possible
before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it will mix with
the helium and cause inaccurate results in subsequent analyses. Or if the valve is open for any length
of time, the air trapped on the high pressure sidemay diffuse back into the gas cylinder and
contaminate its entire contents.

There are twomethods for removing trapped air from the regulator lines: the PurgeMethod and the
EvacuationMethod.

E Maintain High Purity Gases
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EMaintain High Purity Gases

PURGE METHOD

This is the preferredmethod for removing trapped air.

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go toUnit [n] > Show Instrument
Schematic.

If multiple instruments are installed, choose the correctUnitmenu.

2. Close all valves by right clicking each valve, then clickClose.
3. Open the regulator shutoff valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the

high-pressure gauge reads just over half the tank pressure, then quickly close the valve.

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.

6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02MPa), then tighten the fitting.

7. Repeat steps 4, 5, and 6 three times.
8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the regulator

output pressure to 15 psig.
9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.
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EVACUATION METHOD

To use thismethod, the gas tankmust be within 10 feet of the instrument.

1. Do one of the following:

If... Then...
The regulator has not
been filled with gas and
the gas line is attached
to the instrument:

Close the gas cylinder valve.

Open the regulator shutoff valve.

The regulator is filled
with gas:

Close the gas cylinder valve.
Open the regulator shutoff valve.
Loosen the helium inlet fitting (or nut) on the instrument.
Allow all of the gas in the regulator to expel from the line (pressure
reading will be zero).
Retighten the helium inlet fitting (or nut).

2. Go toUnit > Enable manual control (if the instrument schematic is not displayed, go toUnit
> Show instrument schematic).

If multiple instruments are installed, ensure the correctUnitmenu is selected.

3. Close all valves, then open valves 6, 7, and 10.
4. Allow evacuation to continue for 20minutes. This pulls a vacuum on the helium line to the gas

cylinder. Themanifold pressure transducer should fall close to zero.

Allow evacuation for a full 20minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.

E Maintain High Purity Gases
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F WORKSHEETS

Worksheets in this sectionmay be copied as needed.

Sample Data Worksheet for Gas Adsorption on the next page

FWorksheets
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FWorksheets

SAMPLE DATA WORKSHEET FOR GAS ADSORPTION

Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

DegasNotes:
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calibration 10 - 1

load from file 10 - 5
match transducers 10 - 3
sample servo valve 10 - 4
save to file 10 - 5

clean
exterior 11 - 18
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sample tubes 6 - 4

configuration
SmartPrep 5 - 1
unit 2 - 18
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control chart report 7 - 7
convert files 2 - 29
Create New Folder 2 - 32
cryogen requirements 1 - 6

D
dashboard

show 2 - 20
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manually enter 3 - 7
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samples 6 - 8
Smart VacPrep 5 - 4
SmartPrep, start 5 - 3
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f-Ratio method report 8 - 25
fields and buttons, common 2 - 4
files
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filter

port 11 - 23
replace 11 - 23
replace analysis 11 - 23
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replace analysis port filter 11 - 23
replace degas port filter 11 - 24
replace gas cylinder 11 - 9
replace port filters 11 - 23
specify gas ports 2 - 18
vacuum pump 11 - 13

manifold outgas rate 11 - 15
manual control
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enable 11 - 12
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menu structure 2 - 3
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generate 7 - 26
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install
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